
PS Portal Guide
Gateway Specification

Version 6.1 | Update 1/16/19

Notice: This document contains confidential, trade secret information, which is proprietary to Planet 

Payment, Inc., and its subsidiaries (collectively Planet Payment®) and is provided solely for recipient’s 

use in connection with recipient’s participation in one of Planet Payment’s Processing Programs. Planet 

Payment reserves the right to make changes to specifications at any time and without notice. The 

information furnished by Planet Payment in this publication is believed to be accurate and reliable as of 

the date of its release; however, no responsibility is assumed by Planet Payment for its use, nor for 

infringements of patents or other rights of third parties resulting from its use, nor for the violation, 

misinterpretation, or misapplication of any laws, or any regulation of any credit card association 

including Visa, Inc., or MasterCard, Inc. No general license is granted under any patents, copyrights or 

other intellectual property rights owned by Planet Payment and the recipient is only granted an end user 

license to use this information for the purposes of participating in one of Planet Payment’s Processing 

Programs, pursuant to an agreement with Planet Payment or one of its authorized Program partners. All 

modifications or improvements to any of the information and specifications in this document shall 

belong exclusively to Planet Payment, Inc. No unauthorized copying, disclosure or use of this document 

is permitted without the express written consent of Planet Payment, Inc. Planet Payment®, Pay in Your 

Currency®, BuyVoice®, iPAY® and the globe-and-ring logo are trademarks and/or registered 

trademarks of Planet Payment, Inc.© 2018 Planet Payment, Inc. All Rights Reserved 



PS PORTAL  
USER MANUAL  

Document Revision List 
Date Section and name Description of change 
2006-2007 Document Various Updates 
December 12, 
2008 

Document Re-branded to Planet Payment 

May 7, 2009 Document Updated URLs 

November 23, 
2010 

Document 

Added: 
 Wallet (tokenization) features
 Reports
 Multi-Currency Pricing

December 16, 
2011 

Document 
 Updated with Fraud Score and 3D

Secure
 Clarifications for Recurring Billing

July 15, 2014 Document 
 Remove reference to Web Reports
 Add Fraud Reports

DEV_ Specification 2014
Ipay PS Portal Manual 2019

Copyright © 2019 Planet Payment Inc. All Rights Reserved
Confidential and Proprietary Information

ii



PS PORTAL  
USER MANUAL Table of Contents 

Introduction ..................................................................................................... 1 
Data Retention Policy ..................................................................................... 1 
Access and Privileges .................................................................................... 1 
Terminal ........................................................................................................... 3 
Token and Recurring/Wallet Transactions ................................................. 12 

Add a New Token or Recurring/Wallet Customer .................................. 13 
Schedule Information with a Billing Template ....................................... 15 
Schedule Information Without a Billing Template ................................. 16 

Search ............................................................................................................ 20 
Consumer Search ..................................................................................... 20 
Recurring Search ..................................................................................... 23 
Customer/Account Token Search ........................................................... 25 
Advanced Search ..................................................................................... 27 

Transaction Details ....................................................................................... 30 
View Customer Page .................................................................................... 34 

Edit Customer Information ...................................................................... 35 
Delete a Customer (client) ....................................................................... 36 
Add an Account (with schedule) ............................................................. 37 
Edit an Account ........................................................................................ 38 
Delete an Account .................................................................................... 39 
Add a Schedule  ................................................................................................. 40 
Edit a Schedule  .................................................................................................. 41 
Replace a Schedule .................................................................................. 42 
Cancel a Schedule .................................................................................... 42 
Charge this Customer .............................................................................. 43 
Reactivate a Schedule ...................................................................................... 44 

Custom Data Fields ...................................................................................... 46 
Merchant Products ....................................................................................... 48 

Manage Products ..................................................................................... 48 
Modify a Product ...................................................................................... 49 
Modify a Billing Template ........................................................................ 51 
Delete a Product ....................................................................................... 52 
Delete a Billing Template ......................................................................... 52 
Add a Product ........................................................................................... 53 
Add a Billing Template ............................................................................. 56 
Add a Billing Template - Recurring ......................................................... 57 
Add a Billing Template - One-Time Payment ......................................... 62 

Notifications .................................................................................................. 65 
Search Notifications ................................................................................. 65 
Manage Notification Templates............................................................... 66 
Customize a Template ............................................................................. 68 

Pay Pages ...................................................................................................... 71 
Manage Pay Pages ................................................................................... 71 
Modify Pay Page ................................................................................................. 72 
Delete Pay Page ........................................................................................ 72 
Add a Pay Page .................................................................................................. 73 
Manage Image List ................................................................................... 76 
Upload an Image ....................................................................................... 77 

Fraud & Security Tools................................................................................. 78 
Reports .......................................................................................................... 81 

PS Portal ................................................................................................... 81 
Statistics Reports ..................................................................................... 82 

DEV_ Specification 2014
Ipay PS Portal Manual 2019

Copyright © 2019 Planet Payment Inc. All Rights Reserved
Confidential and Proprietary Information

iii



PS PORTAL  
USER MANUAL 

Statements ................................................................................................ 85 
MWEB Statements and Reconciliation ................................................... 86 
Reports ...................................................................................................... 87 
MWEB ........................................................................................................ 87 
Merchant Transactions ............................................................................ 88 
Reconciliation Report .............................................................................. 89 
Fraud Scores ............................................................................................ 94 
Active Schedules Report ......................................................................... 95 
Cancelled Schedules Report ................................................................... 96 
Expiring Cards Report ............................................................................. 97 
Rebill Forecast Report ............................................................................. 98 
Rebill History Report .............................................................................. 100 
Rebill Attempt Report ............................................................................ 102 

Tools ............................................................................................................ 103 
Preferences ............................................................................................. 103 
Change Password .................................................................................. 104 
Help .......................................................................................................... 104 
Log off ..................................................................................................... 104 

Administration ............................................................................................ 105 
Logon As ................................................................................................. 105 
Customer Service Notes ........................................................................ 106 

Glossary ...................................................................................................... 108 
Appendix A - Installation Guide for MagTek Excella STX for ACH ........ 109 
Appendix B—Sample HTTP POST Message ............................................ 114 
Appendix C - Recoverable ARCs ............................................................... 116 
Appendix D – Email Tokens ....................................................................... 117 

DEV_ Specification 2014
Ipay PS Portal Manual 2019

Copyright © 2019 Planet Payment Inc. All Rights Reserved
Confidential and Proprietary Information

iv



PS PORTAL  
USER MANUAL 

Page 1 of 119 

Introduction 
The Payment Solutions Portal (PS Portal) is designed to be 
a single user interface that allows the user to access all 
Web-based applications contracted for. 

The Portal includes a virtual terminal, search features, 
customizable data fields, and the ability to set up recurring 
transactions and pay pages. 

Data Retention Policy 
Planet retains merchant financial and non- financail 
transaction available for 18 months.  

Access and Privileges 
1. To log into the Payment Solutions Portal, go to

https://secure.ipay.com/PSPortal/

2. Enter the username and password
3. Select Login.

The Payment Solutions Portal Home page is displayed. 

Note: The first time the user log in to the Portal (and any time 
your password is reset by an administrator (A password 
can be reset by an administrator upon request), he/she 
will be required to change their password. This security 
feature helps to safeguard your account information. 
The password must be between 8 and 25 characters 
in length and must contain at least one numeric, one 
upper case, one lower case, and one special character. 
Passwords are case-sensitive. See Tools section for 
changing passwords.   
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Access and Privileges 
continued 

The gray navigation bar on the left side of the screen displays 
the available Payment Solutions Portal functions, the 
company number(s), and address of the user.  

Note: The fields and functions which appear in the menu will 
depend on the business model and the services as agreed 
upon with Planet Payment. If a particular function was not 
purchased, it will not be visible in the menu.  Not all fields or 
functions described below will be applicable to all 
merchants. Users will only see functions they do have 
permissions for.  

Throughout the PS Portal, the merchant number is displayed 
in the Merchant field.   If a merchant has more than one 
merchant number in the iPAY Gateway, that number is 
statically displayed.   If the merchant has more than one 
company number, a number can be selected in the 
appropriate field.   

All access and user privileges to the Payment Solutions 
Portal applications are controlled through the centralized user 
application, App Secure. For more information about App 
Secure, see the App Secure Administrator Manual, available 
in the Knowledge Base on
https://secure.ipay.com/AppSecure.  
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Terminal 
The Payment Solutions Portal Terminal allows merchants to 
submit credit card and automated clearing house (ACH), 
payments (ACH is available in the US only) to Planet Payment 
for processing.  

To access the Terminal: 
1. Select Terminal in the gray navigation area.

The Terminal page appears:  

Note: For recurring transactions, see the Token and Recurring 
Transaction section of this document.  
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 Terminal 
 continued 

To complete a transaction: 

1. Enter the following information:

Merchant number If applicable. Ensure that the correct company number is 
selected before submitting any transactions.  

Transaction Type  Select from the drop down menu.   
 Sale
 Auth
 Capture (Auth Code)
 Capture (ID)
 Refund (Saleless)
 Refund (ID)
 Void (ID)
 Reinitiate (ID)
 Client Insert through Schedule Replace (these are

recurring and/or wallet transactions)

Note: See Glossary for more information. 

The fields to complete a transaction varies depending on the 
transaction type selected. For example, transaction types with 
an (ID) indicator, such as Capture (ID), requires only the ID 
field to complete the transaction.  The Client Insert through 
Schedule Replace transactions are for recurring and/or 
wallet transactions.  

Member Number This field allows the user to assign a number to a particular 
customer and then use that number to pull up the customer’s 
information from his or her most recent order for subsequent 
Sale, Capture, and Saleless Refund transactions.  

To assign a new number, enter a number for the customer 
and then complete the transaction process as described 
below. The specified member number is assigned to that 
customer when the transaction is submitted for processing.  

Member numbers should be unique. However, the Payment 
Solutions Portal does not have any uniqueness constraints 
for the member number. 
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Terminal 
continued 

To retrieve a customer’s ordering information: 
a) Enter the customer’s member number in the

Member Number field.
b) Select Fill.

Note:  The customer’s information is populated in the 
terminal. Edit the fields as needed and submit 
the new transaction for processing.  

The Member Number functionality is driven by the 
user’s privileges. The following privileges have been 
set up for the Member Number Lookup function: 
 Single company member number lookup. This

searches for the last transaction of the entered
Member Number for the selected company number.

 Multi-member number lookup. This option
searches for the last transaction of the entered
Member Number for all company numbers
assigned to the user.

Amount Enter the entire amount of the transaction to be charged to 
the account holder, including any applicable taxes. If it is a 
whole-unit amount, the decimal point does not need to be 
included. If it is a partial-unit amount (e.g., 14.95 CAD), then 
the decimal point must be included.  

Currency Select from the drop-down list. 

For more information on currency exchange, see the 
Business Logic Guide. 

Auth Code Necessary only if the transaction type is Capture (Auth 
Code) - obtained from an offline authorization in the 
corresponding field in this section.  

Note: The Auth Code field is not shown for any other 
transaction types.  

Payment Method Select Card or Check (in the US region only).   

Note: The Card/Check selection is only displayed for 
merchants who are enrolled for both services. If a 
merchant uses the iPAY Gateway system to process 
only one type of transaction [i.e., Card or Check], this 
option is not visible. 

The fields to complete will change based on the 
selection.  
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Terminal 
continued Credit Card Transactions 

If Card is selected as the payment method:   
a) Enter the Account # and select the expiration date.
b) Enter the cardholder’s card verification value

(CVV) or CID data for validation, in the CVV/CID
field

Note: The CVV data may be required, based on the merchant 
agreement with Planet Payment. 

The merchant must enroll with American Express to be 
able to submit CID data for validation. 

See applicable section of this document for information 
about CVV validation. 

For complete details about using card verification 
values to help protect against chargebacks and 
fraudulent transactions, see the Business Logic 
Guide. 
Check Transactions
If Check is selected as the payment method:  
a) Complete the Routing # and Account # fields.
b) Complete the Check # (optional except for POP

payments.
c) Select whether the account is Personal or

Business and Checking or Savings.

Note: If the incorrect Account Type is selected (i.e., Business 
when it is Personal or Savings instead of Checking), the 
transaction will be processed, but it may be returned 
later by the bank for invalid Account Type.  

Note: The iPAY Gateway system currently supports ARC, 
BOC, POP, RCK, WEB and Tel ACH payment types.  

Transaction Indicator  For card-not-present merchants.  Select one of the following 
transaction indicators (for card or check transactions) from 
the drop down menu:  

 Mail Order
 Telephone Order
 Recurring
 Secure Internet

Customer Information Enter the customer’s full name and address.  The phone 
number and email are optional fields. The e-mail address 
may be required when utilizing the fraud scoring service. 

Customer Shipping Information Enter the customer’s shipping address. If the shipping 
address is the same as the billing address, check Same as 
billing information to automatically populate these fields. 
This section is optional.  The data is only stored for 
information purposes. 
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Terminal 

 
continued 

 
Swipe Information  This section is only displayed for card-present merchants with 

credit card or ACH swipe capability.  
The iPAY Gateway system supports the ISO 7811 format. We 
recommend the following reading devices: 
 MagTek Wedges and Cherry Keyboards for cards, or

any magstripe reader using keyboard emulation.
 MagTek Excella STX for cards and checks. See

Appendix A for information on installing the MagTek
Excella STX for ACH.

Credit Card Swipe  When a card is swiped through the merchant’s device, the 
track data from the magnetic stripe are sent through the 
Terminal. If the card reader is not working correctly, the card 
number can be key entered in the Account # field (other fields 
will also need to be key entered).  

To complete a swiped credit card transaction: 
1. Enter the Amount and then swipe the card.

Note: If using the MagTek Excella STX device, Select the 
Scan Card button before swiping the card through the 
reader.  

2. Select Submit to complete the transaction.

Note: The account number, expiration date, and cardholder 
name are pulled from the magnetic stripe on the back 
of the card.  

If the checkbox next to Automatically submit on swipe, is 
selected, all subsequent swipe transactions run on that 
computer, for the current user will be automatically submitted 
when swiped (i.e., it will not be necessary to click Submit to 
submit the transaction). This is an optional feature.  

3. Print the receipt for the customer to sign.

ACH Swipe The iPAY Gateway system uses the ACH swipe function for 
Point-of-Purchase (POP) ACH sale transactions, which 
allows merchants to convert a paper check into a one-time 
electronic debit to a customer’s account for the in-person 
purchase of goods or services at the point of sale.  

Note: This type of ACH transaction is limited to personal 
accounts. In accordance with NACHA regulations, 
business checks cannot be accepted for this type 
of transaction.  

To complete a sale transaction: 
1. Enter the Amount of the transaction.
2. Select Scan Check.
3. Run the check through the scanning device.
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Terminal 
continued 

Note: The scanned information will automatically populate the 
Routing #, Account #, and Check # fields. An image of 
the check appears on the Terminal screen  

4. Select Submit after scanning the check.

Void and return the check to the customer.  Have the customer 
sign the receipt, as authorization for the conversion of the 
check to an electronic debit entry.  

Note: The customer’s name and address are not populated 
from the check, nor are they required fields for this type 
of transaction. To search on these fields later, this 
information must be manually entered on the Terminal 
screen at the time of the transaction.  

ACH Swipe is currently only supported through Internet 
Explorer. See Appendix A for more information.  

 Check images can be stored with ACH swipe transactions if the 
user has the privilege assigned.  Images cannot be managed at 
this time (e.g., added later, deleted). Images can be retrieved 
by searching for the transaction and then viewing the 
transaction details. 

5. Enter the customer’s name and address, if applicable.

If the merchant has chosen to validate credit card 
transactions using the address verification system (AVS), 
ensure that the address is entered exactly as it appears on 
the cardholder’s billing statement. AVS settings are 
established when the merchant account is set up in the iPAY 
Gateway system. To change these settings, contact Merchant 
Services. 
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Terminal 
continued 

 Optional Fields 
6. Enter any Optional Fields required, as described below.

These fields are available for Card transactions only.  

If these fields are used, the data is available in the reports 
section as well as any reports sent though the Report 
Delivery System. 

See the Business Logic Guide for a complete description of 
Merchant Descriptors, AVS and CVV verification 

A. AVS Verification Levels 

The iPAY Gateway system only validates these transactions 
when an ARC of 00 (approved) and an AVS response are 
returned in the authorization response. See the Risk and 
Security Tools section of this guide for more information.  

B. CVV Verification Levels 

The iPAY Gateway system only validates these transactions 
when an ARC code of 00 (approved) and a CVV response 
from the issuer are returned in the authorization response. See 
the Risk and Security Tools section of this guide for more 
information.  

The choices in the drop-down list are exact or none.  

C. Fraud Validation 

Refer to the Risk and Security Tools section of this guide for 
more information on Planet Payment’s Enhanced Fraud 
Services.   

Please note that E-mail Address may be required when utilizing 
the fraud scoring service.   

D. Goods Indicator 

Select Physical Goods or Electronic Goods if applicable. This 
field is optional.  

E. Market Specific Indicator 

Currently, one indicator is in use, and it is used to identify 
transactions that are for bill payments. This indicator is useful 
for merchants with a merchant category code (MCC) of 4900, 
as the inclusion of this indicator can qualify transactions for a 
special utility interchange rate with Visa and MasterCard.  

F. Invoice Number 

Enter a unique invoice number if applicable. 
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Terminal 
continued 

G. Tax Amount 

The tax amount field is used to record the tax amount of a 
transaction. If this field is used, the amounts are displayed on 
appropriate reports and can track the amount of tax paid over 
a period of time. This field is not added to the amount field in 
the payment information section, nor is it automatically 
calculated. The amount must be manually entered in this field 
for every transaction to track amounts paid in tax. The tax 
amount may not exceed the total amount of the sale. If a tax 
amount is entered that is greater than the sale amount, the 
transaction will fail and will not be processed.  

H. Custom Data Fields 

This section displays any custom data fields that have been 
defined using the Custom Data Fields function (see section). 
Up to 50 alphanumeric characters of data can be entered in 
any defined field. All these fields are optional.  

Note: User privileges for custom data fields are controlled at 
the Company Number level via App Secure.  

I. Additional Custom Data Fields 

Select the show additional custom data fields link to 
display all user-defined data fields that are still available 
(i.e., they have not been defined or customized as noted 
above).  

Data can be entered in these fields by any user, but the fields 
will not include a customized label. This function may be 
useful for recording one-time notes for a particular order.  

To view the terminal fields submitted:  
1. Select Show transaction request info.

When all required data have been entered: 
2. Select Submit (Sale) (once) to submit the transaction

for processing.

Note: A confirmation message appears, showing whether 
the transaction was successful. 
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Terminal 
continued 

Successful Card and Check Transaction Results  

The transaction result is shown in the response information.  

When a transaction is submitted, the receipt may open 
automatically in a new window. 

Note: This is controlled by selecting Auto Popup receipt 
option in the Terminal privileges in the role assigned in 
App Secure (see the App Secure Administrator 
Manual).  

To view the receipt (manually) 
3. Click Show Receipt.

Sample Card and Check Transaction Receipts 

The Transaction ID number 
is a unique number for 
each transaction and can 
be used to look up 
transactions in the system.  

To print  the receipt select 
Print Receipt or select 
File > Print in the menu 
bar of the pop-up window. 

Note:  Receipts are not  
customizable. 
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Token and recurring/wallet transactions are made up of 
customer (client) information records, account (payment) 
information records, and when recurring, the schedule 
information records (the schedule records set the recurrence 
pattern for the recurring transactions). All possible token and 
recurring/wallet transactions are described below.  

Transaction Type Description 
CLIENT INSERT This inserts a new CLIENT record, which includes the cardholder information, the 

account information, and when recurring, the schedule information. 
ACCOUNT INSERT This inserts a new ACCOUNT (i.e., payment method) for an existing client. For 

recurring a new SCHEDULE must also be inserted with this transaction as the 
iPAY Gateway does not allow recurring accounts without associated schedules. 
The Customer ID must be entered for both types to retrieve the customer 
information. 

SCHEDULE INSERT This inserts a new recurring SCHEDULE for an existing client with an existing 
account. The Account ID must be entered to retrieve the customer information. 

CLIENT MODIFY This allows you to modify customer information (but not account or schedule 
information). The Customer ID must be entered.  

ACCOUNT MODIFY This allows you to modify account information (but not customer or schedule 
information). The Account ID must be entered. 

SCHEDULE MODIFY This allows you to modify schedule information (but not customer or account 
information). The Schedule ID must be entered. 

CLIENT DELETE This allows you to delete a customer record. The customer ID must be entered. 
All associated accounts and any active schedules will be deleted/cancelled when 
the customer is deleted.  

ACCOUNT DELETE This allows you to delete an account record. The account ID must be entered. Any 
associated active schedules will be cancelled when the account is deleted. 

SCHEDULE DELETE This allows you to delete a schedule record. The schedule ID must be entered.  
SCHEDULE 
REPLACE 

This allows you to replace one schedule with another (if, for example, a customer 
is upgrading from one subscription level to another).  

For every transaction except CLIENT INSERT, the Customer 
ID, Account ID, or Schedule ID must be provided to ensure 
the correct associations are performed in the system when 
the transaction is executed. The IDs can be retrieved from 
recurring reports or from the view customer page.  

It is easier to make ACCOUNT INSERT, SCHEDULE 
INSERT, and any MODIFY or DELETE transactions from the 
view customer page because clicking on the edit or delete 
links on the view customer page automatically populates the 
required ID in the Terminal.  

Token and Recurring/Wallet Transactions
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Token and Recurring/Wallet Transactions 
continued 

The iPAY Gateway system does not allow customer and 
account data, for recurring clients to remain in the system 
with no associated active schedule. Therefore: 
 If the merchant has one customer with one account and

one associated schedule, and wishes to delete that
schedule, make the deletion at the customer/client level.

 If the merchant has one customer with multiple accounts,
and one account has only one associated schedule and
wishes to delete that schedule, make the deletion at the
account level.

 If the merchant has one customer with multiple accounts,
and each account has multiple schedules, delete one
schedule using the SCHEDULE DELETE transaction
type.

Add a New Token or Recurring/Wallet Customer 
1. Select Terminal from the main menu.
2. Select Client Insert from the Transaction Type drop-down

list.
3. Complete the fields in the Customer Information and

Account Information sections as described in the Terminal
section for a credit card or ACH transaction.

Select Client Insert

Select Pay Type
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Token and Recurring/Wallet Transactions 
continued 
Add a New Token or Recurring/Wallet Customer (cont’d) 

Pay Type For Token clients, the account entered must be validated by 
one of four methods:  Validation, Sale, Auth or Recur.   The 
options shown are available depending on the merchant’s 
enrollment in the wallet and/or recurring services.   

The Validation option will differ, depending on the Payment 
Method - Card or Check.  For the Check payment method, the 
validation performed on the account is a cursory validation of 
the data entered. There is no real-time validation service for 
ACH transactions.  For the card payment method, the 
validation option will perform an address verification 
transaction (AVS) with the card issuer. 
 Validation* – Wallet payment type that will either perform

an AVS Only transaction to validate the Card account
entered, or if the account type is Check, then a validation
of the routing and account number make-up is performed.

 Sale* – Wallet payment type that will perform a sale
transaction associated with the Customer/Account entered.

 Auth* – Wallet payment type that will perform an
authorization transaction.

 Recur – To add a recurring schedule to the
Customer/Account entered. Choosing Recur will display
the schedule information.

*The asterisk annotates wallet payment types.  If auth or
sale payment type is selected, fields for amount and 
currency will be displayed in place of the recur fields 
shown. 

If Recur is selected, complete the fields in the schedule 
information section that appears in the Terminal. The 
amount of information will differ depending on whether you 
have set up products and billing templates (Billing 
Template section).  

A decline response for the Validation, Sale or Auth payment 
types will cause the Client and Account information to not be 
stored, and no tokens will be created.  Only successfully 
completed verification transactions will result in token storage. 

Amount Enter the amount of the transaction.  For Sale and Auth, the 
amount to be charged to the account holder must be entered, 
along with in the desired currency.   

Transaction Indicator For recurring clients, select recurring. 

Note: The amount of information will differ depending on 
whether or not products and billing templates are set 
up.   

DEV_ Specification 2014 
Ipay PS Portal Manual 2019

                         Copyright © 2019 Planet Payment Inc. All Rights Reserved 
                 Confidential and Proprietary Information



PS PORTAL  
USER MANUAL 

Page 15 of 119 

Token and Recurring/Wallet Transactions 
continued 

Schedule Information with a Billing Template 
If products and billing templates are set up, make the 
appropriate selections from the Product and Billing 
Template drop-down lists. The information for the schedule is 
statically displayed.  

To use a billing template for a new schedule and adjust some 
of the values from the billing template for that individual 
schedule: 
1. Select the product and billing template from the drop-

down lists
2. Select Override billing template values.

Note: The billing template values are populated in the fields, 
but can be edited. Any changes made will apply only 
to the new schedule and will not change the billing 
template (to modify a billing template, see Modify a 
Billing Template section). The new, edited schedule 
will still be associated with the selected product and 
billing template.  

Note: Values from the billing template for Merchant Name, 
Merchant Phone, Merchant State, and the AVS and 
CVV settings in the optional fields section can be 
overwritten. These fields are not populated from the 
values in the billing template, but data entered in 
these fields when the new schedule is created will 
override the values in the billing template.  

Product and
Billing Template

DEV_ Specification 2014 
Ipay PS Portal Manual 2019

                         Copyright © 2019 Planet Payment Inc. All Rights Reserved 
                 Confidential and Proprietary Information



PS PORTAL  
USER MANUAL 

Page 16 of 119 

 Token and Recurring/Wallet Transactions continued 

 Schedule Information Without a Billing Template 

If products or billing templates have not been set up in the 
Portal, the Product and Billing Template drop-down lists will 
be empty.  All parameters must be entered.  

1. Enter the following information:

Amount of the transaction Enter the entire amount of the transaction, including any 
applicable taxes. If it is a whole-unit amount, the decimal 
point does not need to be included. If it is a partial-unit 
amount (e.g., 14.95), then the decimal point must be 
included. 

Initial amount This is an optional field.  The initial amount is charged only on 
the first billing occurrence. After the first billing, the customer 
is charged the amount entered in the Amount field.  

Currency Select from the drop down list. 
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 Token and Recurring Transactions continued 

Schedule Information Without a Billing Template (cont’d) 

Start Date This is a mandatory field.  It will default to the current day but 
can be edited. The Start Date is the date the customer’s 
schedule becomes active in the iPAY Gateway system. 
Automated notifications will not be sent until the schedule is 
active.  

Note: The Start Date must not conflict with the recurrence 
pattern. For example, if the recurrence pattern bills the 
customer on the 10th of every month, then the Start 
Date must be on the 10th of the starting month.  

 Frequency  
  (for billing the customer) The options are daily, weekly, monthly, or yearly. Within each 

of these selections, choose exactly when to bill the customer, 
whether it be every Monday, the first Tuesday of every month, 
the third Wednesday every January, etc. The selections on 
the screen will change based on the selection of Daily, 
Weekly, Monthly, or Yearly.  

Note: A frequency type and interval cannot conflict with the 
end date of the schedule.  For example, an end date 
that is one year after the start date, with a frequency 
type of Monthly and frequency interval of 14, will get 
an error.  

End Criteria The options are to end the recurring billing after a specified 
number of billing occurrences, after a specified amount has 
been charged to the customer, on a specified date, or None, 
(which means the customer will continue to be charged until 
the schedule is manually cancelled or is cancelled by default 
due to failed billing attempts).  

Billing Method Pre Pay - the customer is billed at the beginning of the cycle 
for the full amount of the cycle. Pre Pay provides the option to 
refund the customer for the unused portion of a subscription if 
the customer should cancel the subscription in the middle of 
the billing cycle.  

Note: Select the box next to Refund on Cancel to refund 
customers when they cancel their subscription. 

If the customer replaces an existing schedule with a 
different product (i.e., upgrades or downgrades), 
he/she will see two transactions on their statement - 
one refund transaction for the residual value of the 
previous schedule and one sale transaction for the full 
amount of the new schedule/ product. 

Post Pay - the customer is billed at the end of the cycle. The 
Refund on Cancel option is not available for Post Pay.  
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Token and Recurring Transactions 

Schedule Information Without a Billing Template (cont’d) 

The chart below shows a graphical summary. 

Start Date and Charge Date Start Date Charge Date 
Pre Pay Must be specified Automatically submitted; same as Start 

Date 
Pre Pay with trial period Must be specified Automatically calculated based on trial 

period and recurrence pattern 
Post Pay Must be specified; must 

be before Charge Date 
Must be specified; must be after Start 
Date 

Post Pay with trial period Must be specified Automatically calculated based on trial 
period and recurrence pattern 

Trial  This is used to set a trial period as well as the amount for the 
trial period. This feature is optional. To set up a trial period for a 
customer, select the length of time for the trial period and the 
amount. For a free trial, enter an amount of 0. If it is not a free 
trial, the customer is billed for the trial amount on the Start 
Date. 

After the trial period, the customer will be charged the regular 
amount (as specified in the Amount field) for the remainder of 
the schedule.  

The iPAY Gateway system limits the duration of a free trial 
period based on the frequency type selected. See below. 

The maximum interval value 
allowed is 

For this frequency type

90 Days
4 Weeks
6 Months
1 Years

Charge Date This field is required if the billing method is Post Pay and 
does not include a trial period. If a trial period is included, the 
Charge Date field is not displayed, and the date is 
automatically calculated by the iPAY Gateway system based 
on the Start Date and the parameters of the trial period.  

If the schedule is set up as Pre Pay with no trial period, the 
customer will automatically be charged on the Start Date. If 
the customer has a trial period, the Charge Date will 
automatically be calculated in the iPAY Gateway system. If 
Post Pay is selected (with no trial period), enter a date in the 
Charge Date field.  The Charge Date must be after the Start 
Date.  

Note: The Charge Date must not conflict with the recurrence 
pattern. For example, if the recurrence pattern bills the 
customer on the 10th of every month, then the Charge 
Date must be on the 10th of the starting month.  

continued 
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Token and Recurring Transactions 
 

Schedule Information Without a Billing Template (cont’d) 

Retry  This is an optional field. Set the parameters the number of 
times rebilling should be attempted and how much time 
should pass between rebilling attempts, should the first 
attempt of rebilling a customer fail. This function is for credit 
card transactions only. It is not available for ACH.  

If this feature is not selected and the first rebilling attempt 
fails, the schedule is cancelled.  

If this feature is selected and all the rebilling attempts fail, the 
schedule is cancelled after the final attempt.  

The Retry Period must be within the rebilling period. For 
example, a retry period of 60 days cannot be set if the 
customer is billed monthly.  

The iPAY Gateway system will re-submit rebill transactions 
only if they fail for reasons that permit a second attempt (a 
“recoverable ARC”). For example, if the first rebill attempt fails 
due to a time out in the system or the customer’s credit limit 
being exceeded, that transaction can be resubmitted. 
However, if a rebill transaction fails due to a non-recoverable 
authorization response code (ARC) (e.g., the cardholder has 
closed his or her account), then that transaction will not be 
resubmitted, and the schedule will be cancelled. See 
Appendix C for a list of recoverable ARCs. The ARC for the 
transaction is listed on the transaction detail page.  

Description This is an optional field.  Enter a description for the schedule.  

Note: The rest of the transaction information (optional fields, 
user-defined fields, and other fields) is the same as 
described for a standard credit card or ACH 
transaction  

When the parameters for have been completed:  
3. Click Submit (Client Insert) to submit the customer’s

new schedule information.

 continued
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Three search options are available: Consumer Search, 
Advanced Search, and the Search Bar.  

Search Bar 
The Search Bar function is available in the upper right-hand 
corner of all pages in the Payment Solutions Portal to facilitate 
a quick search from any screen. 

1. Enter the transaction ID, credit card number, credit card
number, ACH account number, client ID, account ID, or
schedule ID in the Search field.

2. Select the corresponding indicator from the drop-down
menu to identify the type of search value entered.

3. Click Search to execute the search.

The results return transaction details displayed onscreen. 
Consumer Search 

This search function can be used to locate a transaction, token 
account, or recurring schedule for a specific consumer.  

Note: All search results are displayed onscreen and are 
downloadable to a *.csv or *.xls format. Click the 
appropriate link to download in the desired format. 

1. Select Search > Consumer Search.
2. Select Financial Transaction.

Note: The Financial Transaction selection searches for one-
time financial charges and/or all subsequent financial 
transactions associated with a recurring schedule or 
token client. 

Search Bar

Search
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Search   
Consumer Search (cont’d) 

In the search by single value section: 
3. Select a single value, such as:

 a complete credit card or bank account number
 member number, or iPAY-generated tokens, such

as Transaction ID or Client ID.
or:  
In the Search by a combination of the following section, 
4. search on a combination of criteria, such as:

 First Name
 Last Name
 ZIP Code
 the last four digits of the account or credit card

number; and
 Schedule Amount.

Note: In this section, “wild card” searches are automatically 
performed, so that if you enter “SMIT” in the Last 
Name field, all results matching “SMIT” are returned, 
including SMITH, SMITHSON, SMITHFIELD, etc. 

Results will be returned faster if at least three 
parameters are entered. 

In the additional filters for combination searches section: 
5. Select additional filters (company number and date

range) for a combination search. These filters do not
apply to the search by single value search.

In the report options section: 
6. Select the time zone in which the transaction times

should be shown on the report.

Note:  These additional search filters are optional.  

7. Select the appropriate Search button.
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Search 

Consumer Search (cont’d) 
The transaction Search Results will be displayed. 

8. Click the Transaction ID link to view the transaction
detail screen (see section).

Note: If a schedule is associated with that financial 
transaction, a link is shown on the transaction details 
page.  

If the desired schedule is not returned on this search, 
search for recurring schedules using the same search 
criteria by clicking the “Report Search for Recurring 
Schedules with Same Criteria” link at the bottom of 
the page. 

Click the schedule ID link to display the view customer page 
(see View Customer Page section). 

Transaction ID 
link 

Download to 
CSV or XLS 

format
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Search 
Recurring Search 

1. Select Search>Consumer Search.
2. Select Recurring Schedules

In the search by single value section: 
3. Select a single value, such as:

 a complete credit card or bank account number
 Email Address
 Member Number; or
 iPAY-generated tokens, such as Transaction ID,

Schedule ID, or Client ID.
or:  
In the search by a combination of the following section, 
4. Search on a combination of criteria, such as:

 First name
 Last Name
 ZIP Code
 Email Address
 the last four digits of the account or credit card

number; and
 Schedule Amount

In the additional filters for combination searches section: 
5. Select additional filters (company number and date

range) for a combination search. These filters do not
apply to the search by single value search.

In the report options section: 
6. Select the time zone in which the transaction times

should be shown on the report.

Note:  These additional search filters are optional.  

7. Select the appropriate Search button.
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Search  
Recurring Search (cont’d) 

Note: The search results will show the member number, 
customer name, schedule ID, status, amount charged, 
payment method, start date, last billing date, next 
billing date, product name, and company number. 

8. Select the Schedule ID link to display the view
customer page (see View Customer Page section).
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Search  
Customer/Account Token Search 

1. Select Search>Consumer Search
2. Select Customer/Account Tokens.

In the search by single value section,  
3. Select a single value, such as:

 a complete credit card or bank account number
 Email Address
 Member Number; or
 iPAY-generated tokens, such as Transaction ID,

Account ID or Client ID.
or: 
In the search by a combination of the following section, 
4. Search on a combination of criteria, such as:

 First Name
 Last Name
 ZIP Code
 Email Address
 Account Last 4 digits; and
 Transaction Amount

In the addition filters for combination searches section: 
5. Select additional filters (company number and date range)

for a combination search. These filters do not apply to the
search by single value search.

In the report options section (optional):  
6. Select the time zone in which the transaction times should

be shown on the report.

Note:  These additional search filters are optional.  

7. Select the appropriate Search button.

DEV_ Specification 2014 
Ipay PS Portal Manual 2019

                         Copyright © 2019 Planet Payment Inc. All Rights Reserved 
                 Confidential and Proprietary Information



PS PORTAL  
USER MANUAL 

Page 26 of 119 

Search 

 Customer/Account Token Search (cont’d) 

The Wallet Search results will be displayed. 

8. Select the customer name link to display the view
customer page.
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1. Select Search > Advanced Search.

Note: Advanced search is only available for credit card and 
ACH transactions. 

2. Select the transaction type—credit card or ACH.
3. Select the correct company number (if applicable).

Note: To select more than one company number press the 
Ctrl key and the applicable company number(s) in the 
selection box. 

4. Select the date range by entering the dates or selecting
a date range from the drop-down list.

Search 
Advanced Search
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Search  
Advanced Search (cont’d) 

In the transaction types section: 
5. Search for financial transactions or for authorizations

(i.e., pre-auths) only.

Note:  The Pre-Auth option is only available for credit card 
searches).   For Pre-Auth also, select Approved, 
declined, captured or not captured. 

For financial transactions, select debits and/or credits, 
approved and/or declined, settled and/or not settled 
transactions.  

In the card types section:  
6. Select:

 All Credit Cards
 Visa and MasterCard only
 Specific Cards (select the cards to be included in

the search

In the account holder fields section: 
7. Search based on account holder information including

name and zip code.

In the dollar amount section: 
8. Enter an amount range in the search in the amount

section.

In the additional filters section: 
9. Select any additional filters, if applicable.

Note: This section displays the defined data fields to search 
on any of the custom data fields previously defined.  

For example, to find all transactions that included a 
particular fee or were generated as a result of a 
particular marketing promotion, enter the fee or 
promotion code as part of the search criteria.  

In the display options section: 
10. Select the transactions to be displayed.

 Display All Matching Transactions
 Do Not display deleted / voided / invalid

Transactions
 Display Only deleted / voided / invalid Transactions

11. Select the time zone in which the transaction times
should be shown on the report.

Note: To expand these sections, click the + sign next to 
section name.  
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Search  

When all search criteria has been entered: 
12. Select Search.

CC Search Results 

ACH Search Results 

For security purposes, only the last four digits of the account 
number are displayed. The user column shows the user ID of 
the person who entered the transaction in the Terminal. The 
transaction id column contains links to each transaction. Click 
the link to see the transaction details (see Transaction Details 
section).  

 Advanced Search (cont’d) 
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Transaction Details 
1. Click the Transaction ID link number in any search

results screen to display complete details of that
transaction.

Sample ACH Transaction Detail Screen 

For ACH POP sale transactions where the check was swiped, 
an image of the check can be stored with the transaction 
details and can be viewed full-size by clicking on the check 
image.  

Add Transaction 
Notes

Auth Response Code

Note: At this time, only one 
image of the check (the 
front) can be recorded 
and stored in the PS 
Portal. 

DEV_ Specification 2014 
Ipay PS Portal Manual 2019

                         Copyright © 2019 Planet Payment Inc. All Rights Reserved 
                 Confidential and Proprietary Information



PS PORTAL  
USER MANUAL 

Page 31 of 119 

 

Transaction Details  

Sample CC Transaction Detail Screen 

 The Authorization Response code (ARC) and Response Text show 
whether a transaction was approved or declined.  

If the transaction is part of a recurring schedule, the View 
Associated Schedule link will also be visible. Click the link to 
display the view customer page (see View Customer page 
section). This link is not applicable to one time transactions. 

Note This section is used to add notes about the transaction. This is 
useful for customer service representatives. These notes are 
viewable only for the associated transaction. They do not appear in 
the view customer screen.  

Response Textcontinued 
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Transaction Details  
 Links 

The follow up links at the bottom vary depending on the status of 
the transaction. The possible links are as follows: 
 If the transaction is a Sale/Capture or Refund transaction that

has not yet settled, one of two links are displayed: Void (Debit)
for Sale/Capture or Void (Credit) for refunds. These links allow
the user to void the entire transaction. Only unsettled
transactions can be voided, and they must be voided for the
entire amount. Partial voids cannot be performed. If a partial
amount must be refunded or an entire sale must be reversed
after it has settled, use the Refund Transaction Type in the
Terminal. Click the Void (Debit) or Void (Credit) link to view
the Terminal screen, pre-populated with the transaction
information. The information is grayed out and cannot be
edited.

To process the void, click Process at the bottom of the
Terminal page. If an unsettled transaction has already been
voided, this link does not appear.

 If the transaction is a Sale/Capture transaction that has been
settled, a Refund link appears, which allows the user to perform
a complete or partial refund of the transaction.   Click the
Refund link to view the Terminal page, pre-populated with the
transaction information. The amount field can be edited, but the
amount cannot exceed the original sale amount.

To process the refund, click Process at the bottom of the
Terminal page.

 If the transaction is a Refund transaction that has settled, no
link is available because no further action on this transaction is
allowed.

 If the transaction is an Authorization transaction, the available
link is Capture. This link allows the user to capture a previously
authorized credit card transaction. Click the Capture link to
view the Terminal screen, pre-populated with the
authorization transaction information. The information is
grayed out and cannot be edited, except for the amount
field. An authorization can be captured for any amount up
to the authorized amount.

To process the capture, click Process at the bottom of
the Terminal page.

The area circled in purple displays the fraud score
response details for the transaction.  This section will only
appear if the merchant account is subscribed to the
service.   See the Risk and Security Tools section of this
guide for detailed information on these values.

continued
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Transaction Details  continued 

After selecting Process for any transaction, a receipt appears 
in a new window with the transaction details. 

Select: 
1. Show Receipt to open a copy of the transaction receipt

in a new window.

Note: The receipt can also be printed by selecting File > 
Print or by clicking Print Receipt on the receipt. 

2. Back to Search to return the user to the original Search
page.
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The view customer screen displays all of the details of a 
consumer’s wallet and/or schedule information. Links are 
available to add, edit or delete an account, client or schedule. 

To access this page: 
1. Perform a search.
2. Select a linked Client or Schedule ID.

Client Information    This section displays the customer’s data.  

Account Information This section shows all accounts that the customer has. 

A customer can have more than one account if he/she uses 
different payment types for separate products. For example, 
the customer might buy one product from a merchant and use 
a MasterCard for payment. Later, he/she might purchase 
another product from the same merchant and use a Visa card 
for payment. The number in parentheses shows the number 
of accounts that customer has. The accounts are available for 
selection in a drop-down list.  

Actions for 
the client

Actions for the 
Account

Actions for the 
Schedule 

Accounts

View Customer Page
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View Customer Page 

The links for Sale on this Account and Auth of this Account will 
display the Terminal page with pre-populated fields for 
customer and account information.  These transactions will be 
linked to this customer and account and will be viewable in the 
Transaction History of the view customer page.   

Edit Customer Information 
From the view customer page: 

1. Select Edit from the Actions for this Client section, to
display the screen below.

2. Edit the customer information fields as needed.

Note: The ID number is a unique, iPAY-generated identifier 
for a customer. This value cannot be edited. 

When all edits have been completed:  
3. Click Submit Client Modify to save changes.

continued 
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View Customer Page 
Delete a Customer (client) 

From the view customer page: 

1. Select Delete from the Actions for this Client section, to
display the screen below.

In the cancellation information section: 
1. Select the Cancel Effective date.

Note: Select a specific date or end of the cycle for the 
cancellation to be effective. 

2. Select Process residual amount to refund the
customer for the unused portion of the schedule (for
Pre-Pay) and charge the customer for usage up to the
cancellation date (for Post-Pay).

Note: Active accounts and schedules associated with the 
customer are noted on the screen. Deleting the 
customer record removes the customer and all 
associated accounts and/or schedules from the 
system. If the customer has active subscriptions, 
these subscriptions will be cancelled when the 
customer is deleted. 

To complete the deletion of the customer/client: 
3. Click Submit Client Delete.

Active accounts and 
schedules associated 
with the customer 
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View Customer Page 
Add an Account (with schedule) 

From the view customer page: 
1. Select Add an Account from the Actions for this Client

section, to display the screen below.

2. Enter the new account information (see Terminal section).

Note:   If recurring, a new schedule must be created at the 
same time in the schedule information section.  

3. Click Submit Account Insert to save the changes.
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View Customer Page 
Edit an Account 

From the View Customer page: 
1. Click Edit from the Actions for this Account section, to

display the following screen.

2. Change the payment type (in the Account Information
section).

To save changes: 
3. Click Submit Account Modify.

If there is an associated schedule, it will continue with the 
new payment method. 

Note: The Account ID is a iPAY-generated unique identifier 
and cannot be edited. 
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From the View Customer page: 
1. Click Delete from the Actions for this Account section, to

display account being deleted and if recurring, its
associated schedule.

In the cancellation information section: 
1. Select the Cancel Effective date.

Note: Select a specific date or end of the cycle for the 
cancellation to be effective. 

2. Select Process Residual Amount to refund the
customer for the unused portion of the schedule (for Pre-
Pay) and charge the customer for usage up to the
cancellation date (for Post-Pay).

To complete the deletion of the customer/client: 
3. Click Submit Account Delete.

Select the Cancel
Effective date and 
Process Residual
Amount as applicable

View Customer Page
Delete an Account  
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View Customer Page 
Add a Schedule   

To add another schedule to an existing account:  

From the View Customer page: 
1. Click Add a Schedule from the Actions for this Account

section, to display the following screen.

2. Enter the data for the new schedule in the schedule
information section. See Terminal section.

When the necessary fields are complete: 
3. Click Submit Schedule Insert.

In the schedule information section of the view customer 
screen, view the details of all schedules associated with a 
consumer.  

An individual customer can have more than one schedule set 
up in the Payment Solutions Portal. For example, the customer 
might buy one product and use a MasterCard for payment. 
Later, the customer might purchase another product and use a 
Visa card for payment. The number of schedules is shown in 
parentheses, and a drop-down list of the schedules is 
available to select which schedule to view. 

The links for Sale on this Account and Auth on this Account 
will display the terminal page with pre-populated fields for 
customer and account information.  These transactions will be 
linked to this customer and account and will be viewable in the 
transaction history of the view customer page.   

Each schedule can be edited, replaced, or cancelled. 
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View Customer Page 
Edit a Schedule   

From the view customer page: 
1. Select Edit from the Actions for this Schedule section:

Note: The Schedule ID is an iPAY-generated unique identifier 
and cannot be edited. 

The Edit links displays the following screen.  Fields are pre -
populated with the existing schedule information.  

2. Edit the fields as needed.
3. Click Submit Schedule Modify to submit changes.

Note: To change the customer’s next rebill date (for example, 
to skip one month’s payment to give that customer a 
free month), click Edit. In the schedule information 
section, edit the Next Bill Date field. The customer will 
not be charged until the date shown in the Next Bill 
Date field.  
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View Customer Page 
Replace a Schedule 

From the view customer page: 
1. Select Replace from the Actions for this Schedule

section, to upgrade or downgrade a customer’s
schedule.

For example, If three different products—a bronze, silver, and 
gold subscription program. A consumer who signed up for a 
12-month bronze subscription might decide after six months 
that he/she would like to upgrade to the silver or gold level. 

The same screen as displayed above for Edit a Schedule 
appears.  

In the schedule information section: 
2. Select the new Product and Billing Template from the

appropriate drop-down lists (or enter the changes
manually).

When all changes are complete.  
3. Click Submit Schedule Replace.

The Payment Solutions Portal automatically handles the 
residual amounts from the initial subscription based on the 
parameters selected in the schedule or billing template.  

Cancel a Schedule 
From the view customer page: 
1. Select Cancel from the Actions for this Schedule section.

The same screen as displayed above for Edit a Schedule 
appears, with the schedule information is statically displayed.  

2. Click Submit Schedule Delete to delete (i.e., cancel)
this schedule.

This action will cancel only the schedule selected. All other 
schedules and account and customer information remain 
active.  

In the cancellation information section: 
3. Select the Cancel Effective date.

Note: Select a specific date or end of the cycle for the 
cancellation to be effective. 

4. Select Process Residual Amount to refund the
customer for the unused portion of the schedule (for Pre-
Pay) and charge the customer for usage up to the
cancellation date (for Post-Pay).
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To complete the deletion of the customer/client: 
5. Click Submit Account Delete.

Note: If there is only one active schedule for an account, the 
account or the entire client record must be deleted. 

Note: If Pre Pay and Process Residual was selected when 
the schedule was set up, and the schedule is cancelled 
but the initial or rebill sale transaction has not yet 
settled, the iPAY Gateway system voids the initial or 
rebill sale transaction for the canceled schedule.  

Charge this Customer 
From the view customer page: 
1. Select Charge this Customer from the Actions for this

Schedule section to process a one-time charge against a
recurring customer.

When the Terminal page appears: 
2. Enter an amount.

Note:  The transaction does not affect the customer’s current 
schedule(s) and will not change the next billing date 
of any schedule. The transaction will be recorded in the 
transaction history section. 

3. Select Submit Sale.

View Customer Page
Cancel a Schedule con't 
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View Customer Page 
 

Reactivate a Schedule 

In certain circumstances, a schedule that was cancelled can be 
reactivated.  To be valid for automated reactivation, a cancelled 
schedule must meet the following criteria: 
 The schedule must have been cancelled within the past 18

months. If it has been cancelled for longer than that, it
cannot be reactivated.

 The schedule was originally set up/created without an end
date, end amount, or end count (e.g., an “open ended”
subscription).

If a schedule was created with an end date, end amount,
or end count, and the schedule was cancelled at any time
during the subscription period (due to expired card or
natural end of the cycle or whatever), then the automated
reactivation will not work. For these schedules, the
customer must sign up again for the service.

From the view customer page: 
1. Select Reactivate (this link will not appear if the

schedule is not valid for automated reactivation).

Note: The page will refresh. A message confirming 
successful reactivation appears on the screen after the 
screen refreshes.  

Depending on when the schedule was canceled and 
the billing cycle for the schedule (monthly, weekly, 
etc.), the Next Billing Date might show as being in the 
past. When the system refreshes, the correct date will 
be recalculated and displayed.  

Reactivating the schedule will not bill the customer for 
any missed months between the time of cancellation 
and the time of reactivation. For example, If a schedule 
that was billed monthly, was cancelled in July 2011 and 
reactivated in October 2011. The customer will not be 
billed for August or September.  

When a schedule is reactivated, the customer is 
immediately activated for that subscription. If a 
customer has a subscription for “Webservices ABC” 
reactivated in the middle of October, and the schedule 
was created to bill the customer on the first of the 
month. The next billing after the reactivation will be 
November 1, but the customer will have an active 
subscription as soon as the schedule is reactivated. It 
is up to the merchant to decide whether to give the 
customer this “in between” time for free or to charge 
the customer a one-time, pro-rated price for a partial 
month of service (using the Charge this Customer 
function).  
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View Customer Page 
Reactivate a Schedule (cont’d) 

Additional Information At the bottom of the view customer page, additional 
information is available. This information can be viewed one tab 
at a time, or all at once (by selecting All) The screen below 
shows the All view.  

Transaction History This tab shows all transactions for a selected account. The 
date and time, amount, type, and payment method for the 
transaction are all displayed.  

If the value in the Status column is NOT Success, click the 
Transaction ID link to view the transaction details and see the 
response codes, which provide the reason for the transaction 
failure.  

The Actions column displays possible actions for the listed 
transaction. Click the linked action to display the Terminal 
page to perform the function.  

Email History This tab shows all emails that sent to a consumer for a 
selected schedule. The subject, sent from address, sent to 
address, sent date, and send status are all displayed. In the 
Subject column, click the email link to see the content of the 
email sent to the customer. The email can also be re-sent. 

Note: If an email fails because of an incorrect email address, 
change the email address in the customer information 
portion of the view customer page before re-sending 
the email. 

Schedule Notes This tab allows customer service personnel to enter or view 
any notes applicable to the selected schedule.  

To add a note, click Add a Note. Schedule notes are 
viewable only in this area; they are not seen on any other 
screens.  

Once entered, they are viewable by anyone who views that 
customer’s schedule.  

Related Schedules This tab lists all related schedules for a particular consumer. 
The start date, status, last four digits of the associated 
account number, recurring billing amount, and schedule ID 
are all displayed.  

View: 
 Transaction History
 E-mail History
 Schedules Notes
 Related Schedules
 All
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Custom Data Fields 
Twenty custom data fields are available in the Payment 
Solutions Portal. These fields allow a user to enter and track 
data that is relevant to their business model. Some examples 
of uses of these fields include product ID, employee ID, 
warranty level, promotion code, and general ledger account 
number. Access to this function is controlled through the 
settings in AppSecure. See the AppSecure Administrator 
Manual.  

To set up custom data fields: 
1. Click Custom Data Fields in the gray navigation bar on

the left side of the Home page.
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Custom Data Fields 

In the configure section: 
2. Select:

 The company number (if applicable)
 Show Custom Fields on Receipt (All or Nothing) -

to have all custom fields and their values appear on
the receipt.

Note:  You cannot choose to have some fields appear and 
have others remain unprinted.  

 Save Data for all Company Numbers - to have all
custom data fields apply to all company numbers

Note: The modification information in gray on the right side 
of the configure section is system-generated for audit 
purposes and cannot be edited.  

In the User Defined Fields section: 
3. Enter the name of the label for the field as it is to appear

on receipts or reports. The fields can hold up to 50
alphanumeric characters.

When all custom fields have been assigned labels: 
4. Select Save.

Note: The data from all 20 fields are shown/reported in 
various Portal, MWEB and Report Delivery Service 
reports, however only the first 10 fields are searchable 
using the Payment Solutions Portal Search function.  

Note: If a label needs to be changed after it is set up and 
transactions have been processed using that label, the 
label will change for all previously submitted 
transactions. All historical data will reflect the new 
custom data field label.  

If a user changes the custom fields for one company 
number, it changes the custom fields across the company 
number (i.e., the changes are not user-specific).  

continued 
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Merchant Products 
Merchants who use the Pay Page and/or recurring functions 
of the iPay Gateway system can set up their Products and 
Billing Templates. 

Products and Billing Templates serve two purposes. 
Products act as “containers” for a set of billing templates. 
Within each product, one or more billing templates can be set 
up.  

For recurring, Products and Billing Templates are used 
together to set up recurring schedules for customers that 
need to be billed a specified amount on a regular schedule, 
for a specified period of time.  

For example, to set up a monthly billing template with an 
additional start-up fee (initial amount), a monthly billing 
template with a free trial period, and an annual billing 
template. These templates make it easier to create a 
schedule for a new customer, as the billing parameters are 
automatically populated in the Terminal when the Billing 
Template is selected (see Terminal section). 

For Pay Pages, Products and Billing Templates also serve as 
the basis for the Pay Page configuration, and tell the Pay 
Page application how the consumer should be billed:  on a 
recurring basis using a pre-defined schedule, or a one-time 
payment. 

Manage Products 
To view and manage all products created,  
1. Select Merchant Products > Manage Products.

2. Select the Company Number whose Products are to be
displayed, if applicable. 

Products are listed with their associated Billing Templates 
underneath. The product names are hyperlinked.  
 Click the link to display the modify product information

page and edit the product, if needed.
 Click the link to display the “modify billing template”

page and edit the billing template settings, if needed.

Select Product 
Name or Billing 
Template 
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Merchant Products 
Modify a Product 

1. Select Merchant Products > Manage Products.

On the product summary page: 
2. Select the product name link to modify.

3. Modify fields as applicable.
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Merchant Products 
Modify a Product (cont’d) 

Note: The company number and product ID cannot be 
modified.   The product ID is a unique number 
generated by the iPAY Gateway system when the 
product is first saved.  

The Type selection (One-Time Payment or 
Wallet/Recurring) cannot be modified. 

See Add a Product Section for information on the product and 
customer service information fields. 

The event fields are described in the Notifications Section, and 
are applicable to wallet/recurring and non-recurring product 
types. 

4. Select:
 Save Product to save changes.
 Cancel to exit without saving changes.
 Delete Product to delete the product.
 Add Billing Template to add a new billing template

for this product.
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Merchant Products 
Modify a Billing Template 

Billing templates are used to set the criteria for recurring 
payments for a subscription (if recurring), or to identify the 
billing method of Authorization or Sale transactions. 

1. Select Merchant Products > Manage Products.

On the product summary page: 
2. Select the billing template name link of the billing template

to be modified.  

3. Modify fields as applicable.

Note: The company number and product ID cannot be 
modified.    

Any changes to a recurring billing template are applied 
only to new schedules going forward. 

The billing template and billing descriptor information 
fields are explained in the Add a Billing Template 
section. 

The event fields are described in the Notifications 
Section and are applicable only to recurring billing 
templates. 

These fields cannot 
be modified
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Merchant Products 
Modify a Billing Template (cont’d) 

5. Select:
 Save Billing Template to save changes.
 Delete Billing Template to delete the template.
 Cancel to exit without saving changes.

Note: Changes to billing templates are not immediately 
available. The system refreshes the publication of billing 
templates every 15 minutes. 

Delete a Product 
1. Select Merchant Products > Manage Products.

On the product summary page:  
2. Select the product by clicking the linked product name.

On the modify product information screen: 
3. Click Delete Product.

Delete a Billing Template 
1. Select Merchant Products > Manage Products.

On the product summary page:  
2. Click the linked billing template to be deleted.
3. Click Delete Billing Template.

Note: Billing templates cannot be deleted if there are any 
active recurring schedules attached to the billing 
template.  
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Merchant Products  

Add a Product 

1. Select Merchant Products > Add Product or click Add
Product from the product summary page.

Add Product Information page – One-Time Payment example 

2. Select the Company Number to which the product will
belong.

In the product information section: 
3. Enter the product name and description. The description

can be text or a URL.
4. Select the Type based on the following descriptions of

each option.  The product type will drive the types of
billing templates that can be created beneath them.
The options shown above may differ according to the
specific merchants service subscriptions.
 One-Time Payment - Choose this option if you do not

want to store customer and account information for
the customer in a wallet.

 Wallet / Non-Recurring – chose this option if you want
to use this product to store customer and account
information in a wallet for one-time (non-recurring)
payments.

Note:   The Product Type selection plays an important 
role in how the child billing templates will behave 
in the system. 

 Wallet/Recurring -  Chose this option to use this
product to create billing templates with recurring
schedules

5. Enter the following information in the customer service
information section:
 Website of the product.
 Domestic and international customer service phone

numbers. The numbers entered in these fields are
available as the CUSTOMER_SERVICE_EMAIL
tokens for customized emails (see Token and
Recurring Transaction Section).
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Merchant Products 
Add a Product (cont’d) 

6. Complete the following information in the event
subscription for consumers section:
 Event mail TO address - the email address to which

product-level events should be emailed. For example,
to have all cancelled schedule event notifications
emailed to the customer service group so they can
contact the consumer to find out why they cancelled.

 Event mail FROM address - the email address to
appear in the customer’s inbox. Although the event
notification emails are sent from the iPAY Gateway
system, entering a different address in this field will
make it appear as if they are coming from the
merchant/company. The address you enter in this field
will be the CUSTOMER_SERVICE_EMAIL token if
customized email notifications were created (see
Notifications Section).

 POST notification URL field - the URL to which you
want background events posted.

Note: Event Notifications are only available for Wallet / 
Recurring product and billing template types. 

7. Select the events for which notifications should be
received.

Note: To select notifications for the consumer to receive, see 
Notifications Section). This section is available for 
completion only after a new product has been saved in 
the system. 
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Merchant Products 
Add a Product (cont’d) 

Event Subscription for Consumers 

To enable the event notification, check the box next to the 
appropriate event name. 
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Merchant Products 
Add a Product (cont’d) 

In the notification method column: 
8. Select:

 Email - If selected, also select the template for the
notification. Planet Payment has created basic email
templates for some notifications, which can be
customized. (see Notifications Section).

Different notifications can be created to be sent 
internally and externally for the same event.  

 HTTP post - to receive notifications via HTTP post,
enter the dynamic listener page URL in the POST
notification url field. Select the notifications to receive,
and then select either “HTTP POST” or “BOTH” as the
notification method.

Note: HTTP POST notifications are not customizable. The 
real-time POST notification received will include 
comma-separated name-value pairs for all relevant 
transaction data.  

Data can then be parsed and updated to a local 
database.  

HTTP POST is generally a reliable messaging method, 
but it can fail due to connectivity or listener page 
issues. The iPAY Gateway system will attempt delivery 
of an HTTP POST message four times before 
declaring it a failed message. All notifications 
(successful or failed) are recorded in the PS Portal and 
can be searched on and re-submitted.  

A sample HTTP POST is shown in Appendix B. 

9. Select Save Product or Cancel to exit without saving
the changes.

Add a Billing Template 
Billing templates are used to set the billing parameters for a 
particular product. There are two types of billing templates, 
and each is determined by the product type with which it will 
be related.  If the product type is Wallet / Recurring, then the 
billing templates created underneath of it will contain 
recurring billing parameters such as amount and currency, 
frequency (monthly, etc), duration of billing cycle, trial period 
options, etc.  If the product type is Wallet / Non Recurring or 
One-Time Payment, then their associated billing templates 
will have parameters for the type of payment (auth or sale), 
and soft decline options for address, CVV2, and Enhanced 
Fraud Services. (See Fraud and Security Tools section).  

See sections - Add a Billing Template – Recurring and Add a 
Billing Template – One time Payment 
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Merchant Products 

Add a Billing Template - Recurring 

There is a lot of flexibility in the PS Portal recurring billing 
templates. 

Recurring Considerations: 

Recurring billing is similar to setting up at repeating meeting 
in Outlook.   The customer will be billed the amount indicated 
at the frequency selected.  

For example, a customer can be billed annually for a three-
year subscription and have the billing end either after three 
occurrences or on a date specified.  

If the business model is for installment payments, the 
merchant can bill customers a specified amount at set 
intervals up to a designated amount. For example, you can 
create a billing template that will bill customers $25 US dollars 
a month up to $100. The “end amount” (in this case, $100) 
must be an exact multiple of the installment payment, or the 
transaction will fail.  

Billing templates can also be set up to have an introductory, 
or initial, amount, followed by regular, set payments.  

Once the billing templates are created, they can be selected 
when creating a new Wallet/Recurring customer in the 
Terminal.   

Selecting a billing template saves time because the 
information does not need to be entered for each parameter 
for the schedule information.  

Individual values populated from a billing template can be 
changed for a new schedule 

Billing templates must be created if Planet Payment’s hosted 
pay pages are used. See Pay Pages Section. 

To add a billing template: 
1. Select Merchant Products > Add Billing Template.

Note: The screen is similar to the schedule information 
section in the Terminal. 

Note: Billing templates are not immediately available after 
creation. The iPAY Gateway system refreshes the 
publication of billing templates every 15 minutes.  

2. Select the appropriate company number from the drop-
down list at the top of the page (if applicable).

3. Select the product with which the new billing template is
to be associated.
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In the billing template information section: 
4. Enter a Name and Description for the new billing

template.  

Billing Termination Condition Indicate whether the schedule should end after a specific 
amount has been charged to the customer, after a specific 
number of occurrences (i.e., rebill transactions), on a specific 
date or have no end date for the schedule.  

If no end date is selected, the schedule must be manually 
cancelled.   

Frequency Type Set the frequency of the rebilling cycle. Select daily, weekly, 
monthly, or yearly. 

Frequency Interval  Enter a numeric value.  

For example, if a customer is to be rebilled every month, 
select “Monthly” in the Frequency type field and enter a 
frequency interval of “1.”  

If a customer is to be rebilled every four weeks, select the 
frequency type “Weekly” and enter “4” in the Frequency 
Interval field.  

Billing Termination
Condition

Merchant Products
Add Billing Template – Recurring (cont’d) 
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Merchant Products 

Add Billing Template – Recurring (cont’d) 

The frequency type and interval cannot conflict with the end 
date of the schedule. For example, If the end date is one year 
after the start date and the frequency type is Monthly, the 
frequency interval cannot be 14. An error message will be 
generated.  

Similarly, the “end after” amount must be divisible by the 
“Amount”. If the customer is billed $15 USD each billing cycle, 
then the “end after” amount must be an exact multiple of (i.e., 
divisible by) 15.  

Note: The Charge Date is set up at the schedule level, not 
in the billing template. See Schedule Information 
Section.   

Amount Enter the amount to be rebilled to the customer with each 
rebill occurrence.  

Currency   Select from the drop-down list. 

Note: All funds settle in the merchant’s settlement currency. 

Has a trial period  Select the checkbox, if applicable. 

a) Enter a number in the first field for the length of the trial
period

b) Select the unit of measure (days, weeks, months, years)
from the drop-down list.

The trial period option can be overridden for each new 
schedule that is set up (see Section Schedule Information 
Section).  

c) If there is a free trial period, enter “0” in the Trial Amount
field. If it is not a free trial, enter the appropriate amount.

Note: There are limits on the length of a trial period. 

Introductory price For the first billing cycle of the product - Select the checkbox 
next to Has an Initial Amount of and enter the amount in the 
corresponding field.  

This amount is only applied to the first billing occurrence. All 
subsequent billings will use the amount entered in the 
Amount field.  
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Merchant Products 

Add Billing Template – Recurring (cont’d) 

Retry occurrence for failed rebills  Select the checkbox to select rebill attempts.  

Days for a maximum of  
Occurrences Enter the number of days between rebill attempts and the 

maximum number of rebill attempts.  

Note: There are only certain failed rebill attempts that can be 
retried. The iPAY Gateway system will retry only for 
those failures that are permitted to be retried by 
Association rules.  

If this option is not selected, the schedule is cancelled after 
the first failed rebill attempt. 

If this option is selected and the maximum number of rebill 
attempts has been reached without a successful result, the 
schedule is cancelled.  

Pre Pay or Post Pay Select from the drop-down list. 

Process Residual  Select Yes or No for Process Residual. For a description of 
these options, see Schedule Information Section.  

Soft Decline Options To decline transactions that do not meet the specifications for 
AVS and CVV settings: 
 Select the checkbox next to Perform AVS verification or

Perform CVV verification  
 Select the level of verification. See Terminal Section for

details.  

Note: These validations are performed only for the first 
transaction. Association rules do not permit the storing 
of CVV data for future transaction validation.   

Paypage Integration Once a Billing Template has been saved, code is generated 
and displayed in the Paypage Code Snippet text box. The code 
can be copied and pasted into the merchant’s Web page(s). 
The code will present the consumer with a button that links the 
consumer to the Planet Payment-hosted pay page for the 
specific product the billing template represents.  

If the billing template is not associated with a specific pay 
page, online customers will be directed to the Planet Payment 
default pay page. 
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Merchant Products 

Add Billing Template – Recurring (cont’d) 
 

Billing Descriptor Information This section is optional. Use this section, to enter a specific 
Merchant Name, Merchant State, and Merchant Phone 
number in the fields provided.  

The values you enter in these fields will appear in the card or 
bank account holder’s statement. This can be useful in 
avoiding chargebacks if the business operates under several 
company names, or if the corporate name is different from the 
“doing business as” name. Using these billing descriptor can 
help to avoid consumer confusion and assist consumers in 
recognizing charges on their statements. 

If no values are entered in these fields, the information is 
populated using the values from the iPAY Gateway system 
merchant profile.  

Registered Internet Payment Service Provider (IPSP) 
merchants, are not permitted to use these fields. 

Note: The use of these merchant descriptors may be limited 
by the settlement provider. See the Business Logic 
Guide for a complete description of this service.  

Event Subscriptions for 
 Consumers Select the events for which notifications should be sent to the 

consumer.  A new billing template must be saved before this 
section (see Notifications Section). 

5. Select Save the New Billing Template or Cancel to
exit without saving changes.
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Merchant Products 

Add a Billing Template 
- One-Time Payment 

One-Time Payment Billing Templates are used primarily by 
merchants who use the iPay-hosted pay pages, and tell the 
Pay Page application which transaction type to use for the 
consumer’s transaction. 

1. Select Merchant Products>Add Billing Template.
2. Select the appropriate company number from the drop

down list at the top of the page.
3. Select the product with which the template is to be

associated.

The figure above shows an example of adding a billing 
template that will be used for Wallet and One-Time payments. 
Note that the cardholder amount and currency will be 
dynamic for these types of transactions, so they are not 
included in this type of template. 

Soft Decline Options are also available with this type of 
template.  Choose the Soft Decline levels of verification for 
CVV, AVS, and Enhanced Fraud Services (Fraud Scoring is 
only available for merchants who are enrolled in the service). 
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Merchant Products 
Add a Billing Template - One-Time Payment (cont’d) 

1. Complete as follows:

Name and Description  Enter a name and description for the new billing template.  

Billing Transaction Types Select the Billing Transaction Type for this template to 
perform: 

Authorization-Only:  This will perform the authorization, but 
the transaction will not settle until a separate Capture 
transaction is submitted.  This processing method is normally 
used for shipping physical goods.  This method is not available 
with ACH payments. 
Sale - This billing transaction type will perform an authorization 
transaction that will automatically settle and debit the 
consumer’s account without any additional action on the 
merchant’s part.   
Validation:  This will perform an AVS-Only transaction when 
the payment type is Credit Card.  For ACH, only the account 
and routing numbers are checked for numeric validity.  Choose 
this option when you are using the Wallet service, and you want 
to add a new Account to a consumer’s wallet. 

Soft Decline Options Choose the Soft Decline levels of verification for CVV, AVS, 
and Enhanced Fraud Services (Fraud Scoring is only 
available for merchants who are enrolled in the service). 

To decline transactions that do not meet the specifications for 
AVS and CVV settings. Select the level of verification. See 
Terminal Section.  

Note: These validations are performed only for the first 
transaction. Association rules do not permit the storing 
of CVV data for future transaction validation. 

Paypage Integration Once a Billing Template has been saved, code is generated 
and displayed in the Paypage Code Snippet text box. The 
code can be copied and pasted into the merchant’s Web 
page(s).  The code will present the consumer with a button 
that links the consumer to the Planet Payment-hosted pay 
page for the specific product the billing template represents.  

If the billing template is not associated with a specific pay 
page, online customers will be directed to the Planet Payment 
default pay page.  
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Merchant Products 
Add a Billing Template - One-Time Payment (cont’d) 

Billing Descriptor Information This section is optional. Use this section, to enter a specific 
Merchant Name, Merchant State, and Merchant Phone 
number in the fields provided.  

The values entered in these fields will appear in the card or 
bank account holder’s statement. This can be useful in 
avoiding chargebacks if the merchant operates under several 
company names, or if the corporate name is different from the 
“doing business as” name. Billing descriptors can help to 
avoid consumer confusion and assist consumers in 
recognizing charges on their statements. 

If no values are entered in these fields, the information is 
populated using the values from your iPAY Gateway system 
merchant profile.  

Registered Internet Payment Service Provider (IPSP) 
merchants are not permitted to use these fields. 

Note: The use of these merchant descriptors may be limited 
by the settlement provider. See the Business Logic 
Guide for a complete description of this service.  

Event Subscriptions for 
  Consumers Select the events for which notifications should be sent to the 

consumer. A new billing template must be saved before this 
section can be completed. See Notifications section. 

Event Notification functionality is only available for recurring 
billing templates at this time.  

Billing templates must be created to use Planet Payment-
hosted pay pages. See Pay Pages section.  

Note: Billing templates are not immediately available after 
creation. The iPAY Gateway system refreshes the 
publication of billing templates every 15 minutes.  
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Notifications 
Use this section to search for notifications (e.g., emails) sent 
to customers, manage customized notification/email 
templates. 

Note:  Event notification functionality is available for recurring 
and non-recurring billing.  

Search Notifications 
1. Select Notifications > Search Notifications.

2. Enter the search criteria, including the date range,
delivery status and any additional filters, as applicable.

3. Select Submit.

Note: Results are returned onscreen in the search results 
section.  

The search results displays the Transaction ID, Email subject, 
Sent from and Sent to addresses, Send date, and Send 
status.  
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Notifications 
Search Notifications (cont’d) 

4. Select:
 View to display the text of the email sent in a new

window.
 Message Template - to view the notification

template page.
 Product to view the modify “Product Information”

page.
 Billing Template - to view the “Modify Billing” page.
 Schedule ID – to display the “View Customer” page.

If view was selected: 
5. Select:

a. Resend This Notification to resend the message to
the recipient, or

b. Close to close the window.

Note: If the initial sending of the email failed due to an 
incorrect email address, the address must be 
corrected in the customer information section of the 
view customer screen.   

Manage Notification Templates 
To customize the notifications sent from the iPAY Gateway 
system. 
1. Select Notifications > Manage Notification

Templates.
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Notifications 
Manage Notifications Template (cont’d) 

On the notification template page: 

2. Select the linked event name.

If a template is available (either default or customized), the 
template name appears on the screen.  

Customized templates are not shared across company 
numbers. If a customized template created is not displayed, 
ensure that the correct company number is selected from the 
drop-down list at the top of the screen. 

3. Select (form the options column):
 View - to display the code for the default email

(default email templates cannot be edited).
 Preview - to see what the email will look like to the

recipient.

Select View or 
Preview
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Notifications  
Customize a Template 

To create a customized template: 
1. Select Notifications > Manage Notification

Templates.  

On the notification templates page: 

2. Select the linked event name.

On the notification templates page: 

3. Click Add new template to create a customized
template for the event selected.

4. Ensure that the correct company number and event
name are displayed.

In the template description section: 
5. Enter a name, description, and subject line for the

custom template. 

Note: The Subject is the subject line that will appear in the 
recipient’s email inbox. 

In the content section: 
6. Enter the text of the message. Available tokens are

listed on the right and are grouped under logical 
headings.  

Text can be entered in plain text or HTML. Double-click the 
desired token and use Ctrl + C and Ctrl + V to copy and 
paste into the content area. For a description of the tokens, 
see Appendix D. 
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Notifications 
Customize a Template (cont’d) 

When the content for the email is completed:  
7. Select Save. The template name will appear under the

template name heading in the available templates
section.

When the new template has been saved:  
8. Select Edit or Preview, as applicable.

Note: Templates can be deleted by selecting the checkbox 
next to the template name and then selecting Delete 
Selected. 

Note:  Once a new template is saved, it is immediately 
available for selection for internal or external event 
notifications.  

Separate customized email templates can be set up to be 
sent to the customer and the customer service group for the 
same event.  

For example:  For a Credit Card Expiration Notice -  an internal 
notification can be created for the customer service group, 
which would instruct them to contact each individual consumer 
as their expiration date approaches.  A different, external 
notification can be sent to the customer, which would ask the 
customer to contact your customer service group with a new 
expiration date.  

Create the two separate templates with different names in the 
Email section of the Portal. Select the internal template in the 
event notification in the Product page, and select the external 
template in the event notification in the Billing Template page.  

Note: Email notifications become active the day after they are 
set up.  

Below is a description of all the event notifications.  
Event notification  Notification is sent when…  
Schedule Create A new schedule is created. 
Schedule Cancel A schedule is cancelled. 
Schedule Replace An existing schedule is replaced (upsell or downsell). 
Process Residual Credit A credit is given to the customer for an unused portion of a schedule.  
Process Residual Debit A debit is charged to the customer for the used portion of a schedule.  

Process Residual Void 

The system attempts to process a residual amount for a canceled schedule 
whose initial or rebill sale transaction has not yet settled. In this situation, 
the system voids the initial or rebill sale transaction for the canceled 
schedule.  
Note: This applies only for schedules with PREPAY and PROCESS 

RESIDUAL selected. 

Billing Approved 
Any recurring charge (related to a schedule) to the customer has been 
successfully completed.  
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Event notification  Notification is sent when…  
Schedule 1st Billing Approved The first recurring charge for a schedule has been successfully completed.  
Schedule Billing Retry 
Approved 

Any approval of a recurring charge after an initial rebill failure.  

Schedule Retry 1st Approved 
The initial rebill attempt fails, but the next billing attempt (i.e., the first retry) 
is successful.  

Schedule Retry 2nd Approved 
The first two rebill attempts fail, but the next billing attempt (i.e., the second 
retry) is successful. 

Schedule Retry 3rd Approved 
The first three rebill attempts fail, but the next billing attempt (i.e., the third 
retry) is successful. 

Schedule Retry 4th Approved 
The first four rebill attempts fail, but the next billing attempt (i.e., the fourth 
retry) is successful. 

Billing Decline 
Any scheduled recurring charge to the customer has failed. This notification 
is not sent for failed retry attempts.  

Schedule Retry Decline 
Any failure of a recurring charge after an initial rebill failure. Merchants 
should select this notification if they do not care to differentiate between the 
1st retry decline, the 2nd retry decline, etc. as noted below.   

Schedule 1st Billing Decline The first recurring charge for a schedule has failed. 

Schedule Retry 1st Decline 
The initial rebill attempt fails, and the next billing attempt (i.e., the first retry) 
also fails. 

Schedule Retry 2nd Decline 
The first two rebill attempts fail, and the next billing attempt (i.e., the second 
retry) also fails. 

Schedule Retry 3rd Decline 
The first three rebill attempts fail, and the next billing attempt (i.e., the third 
retry) also fails. 

Schedule Retry 4th Decline 
The first three rebill attempts fail, and the next billing attempt (i.e., the fourth 
retry) also fails. 

Service start The service to the customer begins. 
Service complete The service to the customer ends. 

Credit card expiration notice 
The customer’s credit card is about to expire. This is sent one month before 
the expiration date. 

Annual billing notification 
The customer is about to be billed for a year’s worth of service. This is sent 
30 days in advance.  

Monthly billing notification 
The customer is about to be billed for a month’s worth of service. This is 
sent 10 days in advance. 

Free trial expiration The free trial period expires (sent day of expiration).   

Schedule Cancelled due to 
Rebill Decline  

The maximum number of rebill retries has been reached without a 
successful transaction or an unrecoverable ARC has been received. The 
schedule is automatically cancelled.  

Account Modify 
Any changes to a customer’s account information (i.e., payment method) 
are made. 

Schedule Modify Any changes to a customer’s schedule are made. 
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Pay Pages 
In the Payment Solutions Portal, Planet Payment-hosted pay 
pages can be set up to accept payments from customers.  

Manage Pay Pages 
To view and manage pay pages that have already been 
created: 
1. Select Pay Pages > Manage Pay Pages.

The manage paypage screen appears, with all pay pages 
listed. 

2. Select the desired Company Number at the top of the
screen, if applicable, to view the pay pages for that
company number.

The pay page listing shows the following information: 
 pay page name
 description
 who added the pay page
 when it was last modified; and
 a link to add a pay page (see applicable section).

` 

Alternatively: 
3. Click the + sign next to a pay page to view its product

and billing template associations.
4. Click the linked pay page name to view and edit all

details of the pay page. (See Modify Pay Page Section).
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Pay Pages  
Modify Pay Page 

To modify an existing pay page: 
1. Click the pay page name link on the manage pay page

screen.

The modify pay page appears: 

All of the information on this page can be modified except for 
the company number that the pay page is associated with.  

For an explanation of all the fields, see Add a Pay Page. 

2. Click Preview Pay Page to preview the page.

When all changes are complete:  
3. Click Save Pay Page.

Delete Pay Page 
To delete an existing pay page:  
1. Select Pay Pages > Manage Pay Pages.
On the manage pay page screen: 
2. Click the pay page name link.
On the modify pay page screen: 
3. Click Delete Pay Page.
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Pay Pages  
Add a Pay Page 

To add a pay page: 

1. Select Pay Pages > Add a Pay Page or select Add a
Pay Page on the manage paypage screen.

The add pay page appears: 

Select the appropriate Company Number from the drop-down 
list at the top of the screen, if applicable. 

In the pay page information section: 
2. Enter a name for the pay page and a brief description.

The description can be text or a URL.

In the payment types section: 
3. Select the payment types to be accepted on this pay

page. Only the payment types set up in the merchant
profile are displayed.
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Pay Pages 
Add a Pay Page (cont’d) 

If the merchant profile is set up to process Pay in Your 
Currency (PYC) transactions: 
4. Select Enable this Pay Page for Pay in Your Currency, if

PYC processing is desired.

If enabled, the pay page application will process as follows: 
When the merchant sends a domestic currency for the 
amount (i.e., the same currency that the merchant clears in), 
the pay page will check to see if the card supplied by the 
consumer is eligible for PYC.   

If eligible: 
An opt-in prompt will be displayed for the consumer to choose 
which amount/currency to pay in; the consumer’s currency 
and converted amount or the original merchant’s currency 
and amount.   

If the card is not eligible for PYC: 
The transaction will be processed as domestic (the same 
currency/amount that the merchant originally passed to the 
pay page). 

Display Shipping fields To capture shipping address information from cardholders, 
select one of the following: 
 No Display - will not display the fields.
 Optional - will display the fields as being optional to

enter.
 Required - will display the fields as required fields.

Note: If additional payment types are required, contact 
Merchant Services.  

In the pay page association section: 
5. Select the billing template(s) to be used on the pay

page being created. This is optional.
  

To select a billing template for a pay page: 
6. Highlight it in the Available Billing Templates box
7. Click Add >> to move it to the Selected Billing

Templates box.

Note: The billing templates in the Selected Billing Templates 
box on the right-hand side will use the pay page being 
created.  

To disassociate a billing template from a pay page:  
 Remove it from the Selected Billing Templates

box by highlighting it and click << Remove to
move it back to the Available Billing Templates.

To disassociate all billing templates from a pay page: 
 Click the Reset Associations button and start

over.
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Pay Pages 
Add a Pay Page (cont’d) 

In the pay page redirection url section: 
8. Enter the URL to which the consumer should be

redirected upon a successful or failed purchase attempt.

Note: If a success/failure URL is not specified, a generic 
page is displayed that lists the form field name/value 
pairs from the transaction. Future enhancements will 
include user-friendly default success/failure pages. 
However, until these default pages are put into place, 
we strongly encourage merchants to create their own 
success/failure pages and specify the URLs in the pay 
page setup. If using the Planet Payment default pay 
pages, include the success/failure URLs when you 
post the billing ID and transaction information to the 
Planet Payment pay page from your Web site. 

In the pay page content section: 
9. Enter the header and footer text in the appropriate

fields. The text must be in HTML.

To include a customized image:  
10. Upload the image to the Payment Solutions Portal (see

the Upload Image section)
11. Call the image in HTML in the header or footer fields

provided.
12. To view images that have already been uploaded, click

the View Uploaded Images link.
13. Click Preview Pay Page, to preview the page.

Note: Save the Pay Page before selecting preview. Newly 
created Pay Pages may not be available for preview 
or use in the Pay Page application for up to 30 
minutes after creation. 

When all changes are complete:  
14. Click Save Pay Page.
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Pay Pages  
Manage Image List 

All images used in Planet Payment pay pages must be 
uploaded to the Portal. Planet Payment does not allow 
redirection to an image on another site.  

Images must be loaded at the company number level. If a 
merchant has more than one company number in the IPAY 
Gateway system and wants to use the same images or logos 
on all your pay pages, then they must be uploaded for each 
company number.  

Files must be *.gif, *.jpg, or *.png format and must not 
exceed 50 kilobytes. 

To view uploaded images: 
Select Pay Pages > Manage Image List.  

The image list is displayed. 

The image list displays all images that have been uploaded, 
the associated company number, the file name, who 
uploaded the image, when it was uploaded, and a thumbnail 
of the image. 

To delete an image:  
1. Select the checkbox in the Delete column next to the

image(s) to be deleted:
2. Click Delete Selected Images.

To upload a new image, see  
3. Select Upload an Image (see the Upload an Image

Section).
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Pay Pages  
Upload an Image 

To upload an image to use in a pay page: 

1. Select Pay Pages>Upload Images, or select the link
from the Image list page or the Add Image link on the
add pay page or edit pay page screens.

2. Select the Company Number that this image will be
associated with, if applicable.

Note: If the merchant has only one company number, the 
number is statically displayed and automatically 
assigned.  

3. Enter a name for the image in the Image Name field.

To select the image:  
4. Click Browse and locate the image to upload.

When the image has been selected: 
5. Click Upload.

The image is now ready use in customized pay pages. 
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Fraud & Security Tools 
Planet Payment recognizes the importance of fraud prevention 
and security in online processing and are committed to offering 
superior protection to merchants and cardholders. Our suite of 
fraud and security tools includes: 

AVS Verification  

The Payment Solutions Portal includes functionality that allows 
the merchant to tell the iPAY Gateway system how to handle 
transactions that failed the AVS check at the issuing bank but 
otherwise were approved by the card issuer.  

CVV Verification  

The Payment Solutions Portal allows the merchant to control 
whether or not to accept transactions that failed the issuing 
bank’s card security code check but otherwise were approved 
by the card issuer.  

Enhanced Fraud Services 

Fraud Validation value enables the merchant to perform up to 
two operations on the pending transaction; score the 
transaction or not, and if a fraud score is requested, perform 
Soft Decline functionality based on the fraud AUTO value 
response if desired.  

The table below lists the Fraud Validation values and their 
meanings.  

Table 1 - Fraud Validation Summary 

Selected 
validation 

level 

Score 
transaction? 

Proceed with 
authorization when Soft Decline when 

None 
No Always Not applicable, fraud score is not 

performed 

Approve Yes AUTO = Approve AUTO = Review, MReview, Decline 

Review 
Yes AUTO = Approve, 

Review 
AUTO = MReview, Decline 

MReview 
Yes AUTO = Approve, 

Review, MReview 
AUTO = Decline 

Any 
Yes AUTO = any value 

[Approve, Review, 
MReview, Decline] 

Not applicable – AUTO response is 
ignored. 
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Fraud & Security Tools 

3D Secure
Merchants who are enrolled in the Planet Payment 3D secure 
service are eligible for 3D secure consumer authentication 
within the pay page application. 

To be compliant with Visa and MasterCard regulations for 3D 
Secure, the merchant must display the Visa and MasterCard 
logos for 3D Secure on their pay page, and link them to a 
contextual window displaying the service benefits for the 
consumer.  To make the task easy for merchants, we have 
provided the necessary images and HTML context for the pay 
page merchants to use in the footer.   

To configure the pay page to display the Visa and 
MasterCard logos: 
1. Display the pay page configuration to edit by selecting:

Pay Pages>Manage Pay Pages.
2. Select the pay page to edit.
3. Within the Footer HTML section, add the following text:

 

 
 
 
 
 
Below is an example of a full footer HTML markup to show the 3D 
Secure lines above within the full context of a footer message: 
 

4. Select Save Pay Page.

<a href= https://paypage.ipay.com/3DSecureicons/LearnMore_MConly.htm” 
Target=”view”onClick=”open (‘ 
https://paypage.iPay.com/3DSecurIcons/learnMore_MConly.htm’, ‘view’,’height=450, 
width=550’);><img src=” 
https://paypage.ipay.com/3DSecureIcons/images /mcsc_learn_more.gif” 
alt=”MasterCard SecureCode” border=”0” /></a> nbsp; <a href=” 
https://paypage.ipay.com/3DSecureIcons/LearnMore_Vlonly.htm’, ‘view’, ‘height=450, 
width=550);”><img src=” 
https://paypage.ipay.com/3DSecurIcons/images/vbv_learn_more.gif” alt=”Verified by Visa” 
border=”0”>< /a> 

</table> 
<center> 
<div id=”Footer” sytle=Margin-top:20px;”> 

<a href= https://paypage.ipay.com/3DSecureIcons/LearnMore_ 
MConly.htm” 

Target=”view”onClick=”open(‘https://paypage.iPay.com/3DSecurIcons/learnMore_MConly.ht
m’, ‘view’,’height=450, width=550’);><img src=” 
https://paypage.ipay.com/3DSecureIcons/images /mcsc_learn_more.gif” 
alt=”MasterCard SecureCode” border=”0” /></a> nbsp; <a href=” 
https://paypage.ipay.com/3DSecureIcons/LearnMore_Vlonly.htm’, ‘view’, ‘height=450, 
width=550);”><img src=” 
https://paypage.ipay.com/3DSecurIcons/images/vbv_learn_more.gif” alt=”Verified by Visa” 
border=”0”>< /a> 

table id=”footerTable” cellspacing=”0” cellpadding =”0” border=”0” 
style = “width:100%; border-collapse:collapse;”> 

</tr>
<td class=”footerLinks” style=”height:25px; background-color: black; color:white; 

font-size:9pt;”>copy; 2010 ACME Products. All rights reserved. <td>  
</tr>

</table>
</div> 
</td> 
</tr> 
</table> 
</body> 
</html> 

continued 
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Fraud & Security Tools continued

When a merchant is enrolled in the 3D Secure service, the pay 
page application will check each consumer who uses the 
merchant’s pay page to see if the cardholder is enrolled in the 
Visa or MasterCard service.   

a. If the cardholder is enrolled, then a screen will be displayed
to the consumer after they initially submit their card number
with the card issuer’s authentication message.

b. If the cardholder is not enrolled, but the card is eligible for
enrollment, then a screen will be displayed for the
consumer to enroll if desired.   If the consumer chooses not
to enroll, then the transaction will be processed as usual,
without 3D Secure authentication.

5. After the consumer successfully completes the
authentication process, the transaction will be
processed and the consumer will be redirected to the
pay page’s configured success or failure URL,
depending upon the outcome of the transaction.

Note: Under certain circumstances, the 3D Secure 
authentication server will return condition values that will 
direct the pay page to ask the consumer for another 
form of payment to complete the transaction.   In this 
case, the consumer will be redirected back to the initial 
pay page input screen where they can enter another 
credit card, or pay with a bank checking or savings 
account (ACH), if the merchant has those services 
enabled within their pay page.  
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Reports  
PS Portal reports offers 
 Statistics
 Statements and MWEB Access
 Merchant Transaction
 Reconciliation Reporting
 Recurring Billing Reports
 Fraud Scores

The reports and search results also contain hyperlinks to drill 
down to the transaction details. 

PS Portal 
Data Availability: 
 For merchants who process in real time to the iPAY

Gateway, card transactional data is available on PS Portal,
immediately.

 For batch files, the data is available within 30 minutes of the
batch processing.

 For ACH transactions, the data is available after the
transactions have settled.

 For card present merchants, the daily data is uploaded
overnight, data is available the next day.

From the main screen: 

1. Select Reports.

Note: Two options will appear:  Web Reports and Recurring.  

Note: All Reports can be opened in CSV or XLS (in a new 
window) by selecting the link under the download icon. 
The report data can then be saved in the selected 
format.   
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Reports  
Statistics Reports 

The Statistics report gives a volume-based breakdown of 
card-based transactions by both card type and transaction type. 
Each section contains information regarding the dollar amount 
and transaction count for each transaction type on each card 
type.  

1. Select Reports>Web Reports>Statistics.

2. Select the transaction type - CC or ACH
3. Select a specific date or date range.
4. Select the company number (if applicable).
5. Select Report.

Note: This report provides a volume based breakdown of 
card-based transactions by both card type and 
transaction type.  Each section contains information 
regarding the dollar amount and transaction count for 
each transaction type on each card type.  The report 
includes the percentage of the total dollar volume and 
transaction volume made up by each transaction type 
and card type. 
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Reports 
Statistics Reports (cont’d) 

If the transaction type CC was selected, the following report will 
appear: 

If the transaction type ACH was selected, also: 
 Select the report Type – Statistics or Compliance

Statistics

Note: The ACH Statistics report provides information on 
volume and percentages by transaction types.  Each 
type includes transaction type totals for dollar amount 
and number of transactions as well as the percentages 
of the overall totals each transaction type accounts for.    

ACH Statistics 
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Reports 
Statistics Reports (cont’d) 

ACH Compliance Statistics 
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Reports  
Statements  

The Statements and MWEB Access section allows merchants 
to view and print a copy of the monthly statement for credit card 
processing charges.   This section also provides access to 
MWEB, Planet Payment’s robust merchant accounting system.   

Note: Statements may not be available for all clients.  

1. Select Reports>Web Reports>Statements and
MWEB Access.

Note: MWEB may not be available for all clients.  

MAS facilitates user access to account and transaction 
information relating to the Pay in Your Currency (PYC) 
process, Shop in Your Currency (SYC), Bank in Your 
Currency (BYC) and domestic services provided by Planet 
Payment. 

MAS is also an online reporting tool for the examination of 
bankcard transactions and associated information, stemming 
from Planet Payment’s processing services.  Using this tool, a 
Merchant, can login and examine pertinent transaction data.   

Using MWEB, merchants can view balance, sales and 
associated fees with their bank account throughout the month, 
rather than waiting to perform month-end reconciliations.  
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Reports 
MWEB Statements and Reconciliation 

1. Select MWEB Statements and Reconciliation to view
reports and transaction information in MWEB.

To provide better daily reconciliation and cash flow 
management, all processing fees payable on the merchant’s 
account will be deducted daily.   

This will open a new browser window to the MWEB monthly 
statement web page.

2. Select Continue.

3. Select the Month and Year from the drop down Menu
4. Select the Format.
5. Select Retrieve Report.
6. Choose Open or Save to save the report as a PDF file.
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Reports 
MWEB 

Roll the mouse over Menu on the left side of the screen. 

A complete MWEB User Guide providing more information on 
other MWEB reports, Transaction information, Chargebacks, 
Bank Reconciliation and features is available online, in 
Menu>Help Center>Documentation. 
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Reports 
 Merchant Transactions 

The merchant transactions section shows the dollar amount of 
fees that the iPAY gateway has collected over a given period of 
time.  

1. Select Reports>Web Reports>Merchant Transactions.

2. Select a specific date or date range using the calendars.
3. Select the company number (if applicable).
4. Select Report.

DEV_ Specification 2014 
Ipay PS Portal Manual 2019

                         Copyright © 2019 Planet Payment Inc. All Rights Reserved 
                 Confidential and Proprietary Information



PS PORTAL  
USER MANUAL 

Page 89 of 119 

Reports  
Reconciliation Report 

The Reconciliation Report provides a total volume 
breakdown of your settled transactions by card type. 
Searches can be performed for periods of one day, a range of 
days (from 1 to 31 days) or an entire month. This page 
provides the ability to view reports for one or more company 
numbers.  

1. Select Reports>Web Reports>Reconciliation.

2. Select a specific date or date range using the calendars.
3. Select the transaction type -  CC.
4. Select the Report type:

 Normal
 View Reconciliation Batch Totals By Day Only
 Settled Transaction Summary
 Settled Transaction Detail

5. Select the company number (if applicable).
6. Select Report.

Normal 
This report shows a summary table of each card type and 
transaction.  The dates are based on the batch date 
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Reports 
Reconciliation Report (cont’d) 

The report also contains reversal transactions. 
Reversals are direct debit transactions that do not 
complete the transaction cycle and are turned around 
(“reversed”) by the system. A reversal has no financial 
impact on the cardholder or merchant.  

Note: Merchants that do not process direct debit or 
EBT transactions, will not see those columns on 
the Card Reconciliation report. 

The Reversals row displays the gross amount of all 
reversed direct debit purchase and return transactions.  

To determine whether the reversals are from purchase 
or return transactions, click the hyperlinked item count 
number in the Reversals row. On the Detail screen that 
follows, click the hyperlinked item count number again. 
In the detail records that follow, the Transaction Code 
column indicates the direction of the original direct debit 
transaction. 

Transaction Code D7 is a credit reversal, which 
indicated the original direct debit transaction was a 
customer purchase. A D7 transaction reverses a 
customer purchase. 

Transaction Code D4 is debit reversal, which indicates 
the original transaction was a customer return. A D4 
transaction reverses a customer refund. 

The original transaction records appear in either the 
Approved Debits (i.e., purchase) or Credits (i.e., return) 
row. 

7. Select any of the transaction counts links to to view the
transaction details for that selection.
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Reports 
Reconciliation Report (cont’d) 

View Reconciliation Batch Totals by Day Only 

Settled Transaction Summary 
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Reports 
Reconciliation Report (cont’d) 

Settled Transaction Detail 

Note: An individual date must be selected.

This report provides the upload number, date, transaction 
number, account number, date and amount of each settled 
transaction uploaded on that date. 

1. Select Reports>Web Reports>Reconciliation.

2. Select the transaction type - ACH.
3. Select a specific date or date range using the calendars.
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Reports 
Reconciliation Report (cont’d) 

4. Select the Report type:
 Normal
 Settled Transaction Summary
 Settled Transaction Detail

5. Select the company number (if applicable).
6. Select Report.

Normal 

Settled Transaction Summary 

Settled Transaction Detail 

Note: An individual day must be selected. 
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Reports  

Fraud Scores 

The Fraud Scores Report provides 

1. Select Reports>Web Reports>Fraud Scores.

2. Select a specific date or date range using the calendars.
3. Select the company number (if applicable).
4. Select the following fields, as applicable:

 Transaction fields
 Fraud Response Code
 ARC

5. Select Report.

6. Select transaction ID to view the transaction detail.
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Recurring Reports  

Active Schedules Report 
This report returns all recurring schedules that are currently 
active (i.e., are still billing the customer and have not been 
cancelled or completed).  

1. Select Reports>Recurring>Active Schedules Report.

2. Select the Company Number (if applicable).  The
default is for all company numbers.

3. Select the time zone (optional).
4. Click View Report. The results are returned onscreen.

The member number, unique schedule ID, name of the 
person submitting the transaction, product name, billing 
template name, start date, last billing date, next billing date, 
payment method, and amount are displayed for each active 
schedule.  
5. Click the Schedule ID link to open the view customer

page.
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Reports 
Cancelled Schedules Report 

The Cancelled Schedules report shows all schedules that 
were cancelled in the queried time period.  

1. Select Reports>Recurring>Cancelled Schedules
Report.

2. Select the Company Number for the report (if
applicable). The default is for all company numbers.

3. Select a specific date or date range using the calendars,
or select a date range such as “Next 2 Months” or “Last
Month” from the Date Range drop-down list.

4. To display search results in a particular time zone,
select the time zone from the drop-down list (all
transactions are processed and stored in GMT).

5. Click Submit.

All canceled schedules are displayed, whether they have 
reached their cancel effective date or not.  

6. Click the Schedule ID link to open the view customer
page. The details of the schedule are displayed on this
page. Schedules that have not yet reached their cancel
effective date can still be edited. Schedules that have
passed their cancel effective date have limited edit
options.
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Reports 
 Expiring Cards Report 

This search allows the user to see the active schedules billed 
against credit cards will expire in the queried date range. 
This allows the merchant to proactively contact customers 
and update their expiration date information, which can 
prevent rejected transactions and interruptions to the 
customers’ service. 

1. Select Reports>Recurring>Expiring Cards Report.

2. Select the Company Number for the report (if
applicable). The default is for all company numbers.

3. Select a specific date or date range using the calendars,
or select a date range such as “Next 2 Months” or “Last
Month” from the Date Range drop-down list.

4. Select Submit.

The returned results show all cards that will expire in the date 
range selected.  

5. Click the Client ID link to display the view customer
page. The expiration date for the card can be edited on
that page.
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Reports 
Rebill Forecast Report 

This report shows the user the number of rebills that are 
expected to be submitted over a queried time period.  

1. Select Reports>Recurring>Rebill Forecast Report

2. Select the company for the report (if applicable). The
default is for all company numbers.

3. Select a specific date or date range using the calendars,
or select a date range such as “Next 2 Months” or “Next
Month” from the Date Range drop-down list.

4. Select Submit.

The report details, in the given time period, the number of 
transactions that will be submitted for their first rebill, the 
number that will be submitted for their second rebill, etc. This 
report can show the trends for new customers versus existing 
customers.  

For example, if the product is a 12-month Web site 
subscription, you could see that X number of customers were 
in their third month of their subscription (i.e., their second 
rebill). 

DEV_ Specification 2014 
Ipay PS Portal Manual 2019

                         Copyright © 2019 Planet Payment Inc. All Rights Reserved 
                 Confidential and Proprietary Information



PS PORTAL  
USER MANUAL 

Page 99 of 119 

Reports 
Rebill Forecast Report (cont’d) 

The second section of this report, Rebill Forecast By 
Attempt, shows the number of rebills that will be submitted 
for the first attempt, second attempt, etc. The number of rows 
in this section of the report is determined by the number of 
rebill attempts set up in the billing templates  

Click the number of transactions link in the report to display 
the rebill forecast results. 

This report shows each schedule that will rebill for the 
selected rebill cycle.  
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Reports 
Rebill History Report 

This report shows the number and amount of all successful 
and failed rebill transactions in a queried time period.  

1. Select Reports>Recurring>Rebill History Report.

2. Select the Company Number for the report (if
applicable). The default is for all company numbers.

3. Select the Product, Billing Template or Payment
Method, if applicable.

4. Select a specific date range using the calendars, or a
date range such as “Last Month” or “Last 90 Days” from
the Date Range drop-down list.

5. To display search results in a particular time zone,
select the time zone from the drop-down list (all
transactions are processed and stored in GMT).

6. Select Submit.

The results are returned onscreen and are displayed by day.  

From the rebill history report: 
7. Select:

 The product link to display the modify product
information page

 The billing template link to display the modify billing
template page

 Total # link(s) to display the rebill details.
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Reports 
Rebill History Report (cont’d) 

Sample Rebill History Report results—Schedule Details 

This report shows the daily detail, including member number, 
schedule ID, customer name, product name, the start 
(charge) date for the schedule, the customer’s payment 
method, the amount charged and the product and template 
name(s).  

8. Click the schedule ID link to display the transaction
detail page.

DEV_ Specification 2014 
Ipay PS Portal Manual 2019

                         Copyright © 2019 Planet Payment Inc. All Rights Reserved 
                 Confidential and Proprietary Information



PS PORTAL  
USER MANUAL 

Page 102 of 119 

 

Reports 
Rebill Attempt Report 

1. Select Reports>Recurring>Rebill Attempt Report.

2. Select the Company Number for the report (if
applicable). The default is for all company numbers.

3. Select a specific date range using the calendars, or a
date range such as “Last Month” or “Last 90 Days” from
the Date Range drop-down list.

4. Select the Product, Billing Template or Payment
Method, if applicable.

5. To display search results in a particular time zone,
select the time zone from the drop-down list (all
transactions are processed and stored in GMT).

6. Select Submit.

The results are returned onscreen and are displayed by day. 

This report shows the daily detail, including company number, 
member number, the attempt number, count and amount of 
rebills, total succeeded and total failed.   
7. Click the billing template to open the modify billing

template page.
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Tools 
The options available in the Tools section in the gray 
navigation area are Preferences, Change Password, Help, 
and Log Off.  

Preferences 
1. Select Tools > Preferences.

The report preferences page appears: 

This section allows the user to choose additional information 
to be displayed in reports.   
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Tools  
Preferences (cont’d) 

To have a specific column shown on the report: 
2. Check the box next to the name of the items in the list of

optional columns; including:
 The level of reporting (reporting hierarchy)
 Download a file containing search results (instead of

displaying results online)

Note: This option will reset after the current session 
times out or is closed.  

 Time zone
 Maximum lines per search results page
 Additional report fields 

Change Password 
1. Select Tools > Change Password.

Note:  This takes the user to AppSecure, the iPAY Gateway 
system centralized password management 
application. 

2. Enter the User ID (i.e., User Name) and old password.
3. Enter the new password twice; once in the New

Password field and then again in the Confirm New
Password field.

4. Select the Submit button to submit the new password
and complete the change password action.

See Access and Privileges Section of this document. 
Help 

From the Tools menu: 
5. Select Help to open the PDF copy of this manual in a

new window.
Log off 

6. Select Log Off to close the Payment Solutions Portal
and return to the Login page.

A link to log off is also available in the navigation area near the 
top of the screen on every page.  
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Administration 
The Administration section allows the user to search for other 
users, logon using another User ID and to add notes. 

Logon As 
1. Select Administration>Logon As menu to display

the logon as another user screen.

Note: This screen provides the ability to logon using another 
User ID or to search for users in the system.   

To search for a user in the system: 
1. Select any of the search parameters:

 User Name
 First Name
 Last Name
 Group Name
 Company Number

2. Enter the search criteria in the applicable field.
3. Select Go.
When the search results appear: 
4. Select the + sign next to the user name to display all

privileges assigned to the user
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Administration 
Customer Service Notes 

Customer service notes can be added by administrators to 
provide useful information to customer service 
representatives. The notes are displayed on the view 
customer page (when the page is accessed. 

To view the note: 
1. Select the View Customer Service Note link in the

upper right-hand corner of the view customer page.

To close the note: 
2. Select Close.

To add a customer service note: 
3. Select Administration > Add Customer Service

Note.

At the top of the screen: 

4. Select the Corporate #. (The Corporate # is set up
internally in the iPAY Gateway system hierarchy.) For
most merchants, only one Corporate # is displayed,
which means that all users with customer service
permissions will see the customer service note.
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Administration 

Customer Service Notes (cont’d) 

In the field provided: 
5. Enter the text for the note. The note can contain up to

4,000 characters and can be plain text or HTML.  

Note: To preview the note, select Preview Note.  

When the note is complete: 
6. Select Save Customer Service Note to save the note.

Note: Only one active note is visible at a time. 
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Glossary 

Transaction Types 

Sale  Submits the transaction and processes it as a complete sale. 

Auth  Submits the cardholder information to the credit card issuer 
and checks for credit availability. 

Capture (Auth code) Allows a merchant to complete a previously authorized sale 
using the approval code from the authorization transaction. 
The auth code must be entered in this transaction. Alphabetic 
characters in an auth code must be capitalized.  
 

Reminder: Authorization codes are valid for a limited time 
(three to thirty days, depending on the 
cardholder’s issuing bank). Captures must be 
completed within the established timeframe. 

Capture (ID) Allows a merchant to complete a previously authorized sale 
using the iPAY -generated Transaction ID from the 
authorization transaction.  

Refund (Saleless) Allows a merchant to refund any customer without having to 
provide a Transaction ID. This functionality is not available by 
default and must be requested by the merchant and approved 
by Underwriting/Risk. This is also known as a saleless credit.  

Refund (ID) Allows a merchant to refund a previously completed sale 
using the iPAY-generated Transaction ID from the previous 
sale or capture transaction. The sale/capture must be settled 
to use this transaction. If it has not been settled, the Void (ID) 
option must be used.  

Void (ID) Used to void a transaction that has not yet settled. If the 
transaction has settled, then Refund (ID) must be used.  

Reinitiate (ID)  For ACH debit sale transactions only (Where applicable). An 
ACH transaction that was returned with reason code R01 
(insufficient funds) or R09 (uncollected funds) can be 
reinitiated a maximum of two times within 180 days from the 
original settlement date. This transaction type will not be seen 
by merchants who are not set up for ACH debit sale privileges 
in App Secure.  
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The purpose of these instructions is to guide users to 
configure their Excella device and Web browser to work with 
the ACH Swipe functionality of the PS Portal.   

Note: Only Microsoft Windows and Microsoft Internet 
Explorer are currently supported for the desktop 
environment to use this functionality. 

The user must have administrative rights for the 
computer on which the Excella device is being 
installed. Otherwise, you will not be able to download 
the required files or install the device.  

For difficulty installing the Excella device, contact 
Planet Payment Merchant Services at 866-704-4729. 

Device Configuration 
Follow Excella instructions 
Two sets of instructions are included with the new Excella 
STX device. Please use the folded, four-page instruction card 
that reads: 

EXCELLA STX INSTALLATION GUIDE 

(RNDIS USB Drivers or Ethernet Only) 
Follow the manufacturer’s step #2 for USB INSTALLATION. 
In this step are three sub-steps: Software Installation, 
Connect Cables, and Device Address Setup. It is especially 
important to carefully follow the Device Address Setup steps.  

When performing the steps for Software Installation, use the 
CD labeled “Software and Drivers” and be sure to install the 
Excella STX Demo as well as the API (select both 
checkboxes on the appropriate screen of the Wizard).  

Additional Configuration 
When you have completed the USB INSTALLATION steps, 
please then do the following: 
1. Go to ftp://Excella:Image2005@ftp.magtek.com
2. In the root drive, click Excella:

Appendix A
Installation Guide for MAGTEK Excella STX for ACH
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Installation Guide for MagTek Excella STX for ACH 
continued 

3. On the next screen, click MagUSB-to-RNDIS:

4. Click ExcellaSTXVBDemo.exe:

5. In the pop-up window that follows, click Save and save
the file to C:Program Files/MagTek/Excella-STX.

Note: This assumes that the default location for the program 
files was not changed during the SOFTWARE 
INSTALLATION. If the default location was changed, 
save this executable to the same location as the 
program files. 

When the file has been saved: 
6. Go to C:Program Files/MagTek/Excella-STX and double-

click the ExcellaSTXVBDemo.exe file to launch it.
7. If a pop-up window opens, click Run.
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Installation Guide for MagTek Excella STX for ACH 

continued 8. In the Excella STX VB Demo window, select STX
STX001or STX_USB (one or the other will be displayed,
depending on the device) in the Device Name drop-
down and then click Open Device.

9. Select the radio button next to RNDIS and click Set.
10. Click Exit to exit the program.
11. Disconnect the reader from the USB port, disconnect

power to the reader, reconnect the power and wait for
the single green light on the front of the reader.
Reconnect the reader to the USB drive. This should
set up all the proper IP connections for the PS Portal.

Additional Configuration - Internet Explorer And Trusted Sites 
In order for the Excella device and images to work correctly: 
12. Add the following to your Trusted Sites:

https://secure.ipay.com
13. Set the security of the trusted zone to either Medium-

Low (Vista) or Low (for XP).
Troubleshooting 

Follow all the above instructions very carefully. Failure to 
follow the instructions exactly can cause a number of issues 
that can vary among users, depending on their systems and 
platforms.  

Optional Test Page for Connectivity  
This is an optional test. 
Once the Excella device has been installed: 
14. Test the connectivity to Planet Payment using a test

page, which allows you to check your settings without
logging onto the PS Portal.
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Installation Guide for MagTek Excella STX for ACH 
continued 

15. Go to:
https://secure.ipay.com/PSPortal/newterminal/home/swipe.htm 

16. Select Scan Device.
17. Scan a check through the Excella reader and ensure that

the check data populates all the appropriate fields.

If the following warning is received: 

18. Adjust the security level of the Internet Explorer
browser. We recommend lowering the security one level
at a time and then re-testing until errors are no longer
received.

In the PS Portal 
If the following error is received when attempting to scan a 
check:  

19. Adjust the security level of your Internet Explorer
browser. We recommend lowering the security one level
at a time and then re-testing until errors are no longer
received.

Security settings 
In Internet Explorer, the Internet security settings can be 
found in Tools > Internet Options > Security. 
The security options vary depending on the version of IE 
used.  
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Appendix B—Sample HTTP POST Message 
HTTP POST notifications received will not include the line 
breaks shown in the sample below (the breaks were inserted 
for readability). Each EVENT_ID has an assigned, static value, 
which is published in the Report Delivery API Guide. We 
strongly recommend that you identify a transaction based on 
the published EVENT_ID value, as the EVENT_DESCRIPTION 
may change as we add events. 

EVENT_ID=0024LTA1444H277K001, 

EVENT_NAME=Schedule Cancel, 
CONBR=99999, 
FIRST_NAME=Joe, 
LAST_NAME=Tester, 
MEMBER_NUMBER=, 
ADDRESS=123 Fake street, 
CITY=Lima, 
STATE=OH, 
POSTAL_CODE=45805, 
COUNTRY=USA, 
CLIENT_ID=9999ZZZXXX9999ZZZXX, 
ACCOUNT_NUMBER=XXXXXXXXXXXX1111, 
EXPIRATION=0710, 
ROUTING_NUMBER=, 
ACCOUNT_ID=9999ZZZXXX9999ZZZYY, 
AMOUNT=7.95, 
INITIAL_AMOUNT=, 
SCHEDULE_ID=9999ZZZXXX9999ZZZWW, 
SCHEDULE_DESCRIPTION=Test schedule, 
CURRENCY_CODE=USD, 
SCHEDULE_LAST_CHARGE_DATE=09/27/2007 05:55:43, 
SCHEDULE_END_AMOUNT=, 
SCHEDULE_END_COUNT=, 
SCHEDULE_END_DATE=, 
TRIAL_FREQUENCY_TYPE=, 
TRIAL_FREQUENCY_INTERVAL=, 
SCHEDULE_TO_DATE_AMOUNT=7.95, 
SCHEDULE_TO_DATE_COUNT=1, 
SCHEDULE_START_DATE=09/27/2007, 
SCHEDULE_CHARGE_DATE=12/25/2007, 
SCHEDULE_CANCEL_DATE=09/27/2007 09:21:58, 
SCHEDULE_CANCEL_EFFECTIVE_DATE=12/25/2007, 
SCHEDULE_EXPIRED_DATE=, 
FREQUENCY_INTERVAL=1, 
FREQUENCY_TYPE=MONTHLY, 
FREQUENCY_DATE=25, 
FREQUENCY_MONTH=, 
FREQUENCY_DAY=, 
FREQUENCY_DAY_SUBTYPE=, 
MERCHANT_NAME=companyxyz.com, 
MERCHANT_STATE=NY, 
MERCHANT_PHONE=888-555-1212, 
USER_DATA_0=1, 
USER_DATA_1=, 
USER_DATA_2=, 
USER_DATA_3=, 
USER_DATA_4=, 
USER_DATA_5=, 
USER_DATA_6=, 
USER_DATA_7=, 
USER_DATA_8=, 
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Sample HTTP POST Message 

USER_DATA_9=, 
USER_DATA_10=, 
USER_DATA_11=, 
USER_DATA_12=, 
USER_DATA_13=, 
USER_DATA_14=, 
USER_DATA_15=, 
USER_DATA_16=, 
USER_DATA_17=, 
USER_DATA_18=, 
USER_DATA_19=, 
PRODUCT_NAME=YouGottaHaveIt, 
PRODUCT_DESCRIPTION=http://www.CompanyXYZ.com, 
PRODUCT_ID=9999ZZZXXX9999ZZZXX, 
PRODUCT_URL=http://www.stuff.com, 
CUSTOMER_SERVICE_PHONE_DOMEST=8885551212, 
CUSTOMER_SERVICE_PHONE_INTL=, 
CUSTOMER_SERVICE_EMAIL=, 
CUSTOMER_SERVICE_WEB_SITE=https://www.CompanyXYZ.com/CS, 
TRANSACTION_TIME=09/27/2007 05:21:58, 
TRANSACTION_ID=9999ZZZZ8888YYYY777, 
TRIAL_AMOUNT=, 
CUSTOMER_EMAIL=joe.tester@ISP.com, 
CUSTOMER_PHONE=, 
EVENT_TIME=09/27/2007 05:21:58, 
BILLING_ID=9999ZZZZXXX888KKK33 
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Recoverable Authorization Response Codes 
Code Text Description 

03 TERM ID ERROR Invalid merchant ID 
05 DECLINE Do not honor 
06 ERROR General error
12 INVALID TRANS Invalid transaction 
13 AMOUNT ERROR Invalid transaction amount 
14 CARD NO. ERROR Invalid card number 
15 NO SUCH ISSUER No such issuer 
19 RE ENTER Re-enter transaction 

25 NO RECORD FOUND 
Unable to locate record in file, or account number is missing 
from inquiry 

27 ERROR Issuer File Update field edit error 
28 NO REPLY Temporarily unavailable 
30 CALL Format error
51 DECLINE Insufficient funds
54 EXPIRED CARD Expired card 
61 DECLINE Exceeds withdrawal limit 
65 DECLINE Activity limit exceeded 
76 NO ACTION TAKEN Unable to locate 
77 NO ACTION TAKEN Inconsistent data, rev. or repeat 
78 NO ACCOUNT No account 
81 ENCRYTPION ERROR Cryptographic error 
91 NO REPLY Issuer unavailable 
92 INVALID ROUTING Destination not found 
94 DECLINE Duplicate transmission detected 
96 SYSTEM ERROR Re-send, system error 
N0 FORCE STIP Force STIP 
N4 DECLINE Exceeds issuer withdrawal limit 
TO (tee-oh) TIME OUT Re-submit 
XA FORWARD 2 ISSUER Forward to issuer 
XD FORWARD 2 ISSUER Forward to issuer 
Z3 UNABLE TO ONLINE Unable to go online, declined. 
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Email tokens are listed and described below. They are 
presented in the table as they are grouped on the email 
templates page. The third column shows the name of the tag 
as it appears in the iPAY Gateway system database.  

Email Token Description XML tag 
Account 

ACCOUNT_NUMBER 
Credit card or bank account number entered on 
the Terminal page. 

ACCOUNT_NUMBER 

EXPIRATION 
The expiration date for a credit card entered on 
the Terminal page. Applies to CC transactions 
only.  

EXPIRATION 

ACCOUNT_ID 
The unique iPAY-generated identifier for an 
account; available on the view customer page.  

ACCOUNT_ID

ROUTING_NUMBER 

The Transit/Routing number entered on the 
Terminal page. It identifies the account holder’s 
financial institution and applies to ACH 
transactions only.  

ROUTING_NUMBER 

Client 

LAST_NAME 
The card/account holder’s last name as entered 
on the Terminal page.  

LAST_NAME 

FIRST_NAME 
The card/account holder’s first name as entered 
on the Terminal page. 

FIRST_NAME 

CITY 
The card/account holder’s city as entered on the 
Terminal page. 

CITY 

ADDRESS 
The card/account holder’s street address as 
entered on the Terminal page. 

ADDRESS 

POSTAL_CODE 
The card/account holder’s ZIP/Postal code as 
entered on the Terminal page. 

POSTAL_CODE 

CLIENT_ID 
The unique iPAY-generated identifier for a 
customer; available on the view customer page. 

CLIENT_ID

COUNTRY 
The card/account holder’s country as entered 
on the Terminal page. 

COUNTRY 

STATE 
The card/account holder’s state/province as 
entered on the Terminal page. 

STATE 

Financial 

TRANSACTION_TIME 
The time that a transaction is processed by the 
iPAY Gateway system  

LOCAL_DATE and
LOCAL_TIME converted to 
GMT 

TRANSACTION_ID 

A unique identifier generated by iPAY for each 
transaction. Transaction IDs can be seen on 
certain search results and are linked to the 
transaction detail page. 

TRANSACTION_ID 

Product 

PRODUCT_NAME 
The product name as entered on the product 
information page 

PRODUCT_NAME 

PRODUCT_DESCRIPTION 
The product description as entered on the 
product information page 

PRODUCT_DESCRIPTION 

PRODUCT_ID 
The unique iPAY-generated identifier for a 
product; available on the product information 
page. 

PRODUCT_ID 

PRODUCT_URL 
Product Web site as entered in the Product URL 
field on the product information page. 

PRODUCT_URL 
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Email Token Description XML tag 

CUSTOMER_SERVICE_ 
WEB_SITE 

The customer service Web site as entered in the 
Website field in the customer service information 
section of the product information page 

No XML tag 

CUSTOMER_SERVICE_ 
EMAIL 

The merchant’s customer service e-mail 
address as entered in the Event mail TO 
address field in the event notification addresses 
section of the product information page  

No XML tag 

CUSTOMER_SERVICE_ 
PHONE_INTL 

The merchant’s domestic customer service 
phone number as entered in the Domestic 
Phone Number field in the customer service 
information section of the product information 
page 

PHONE with TYPE attribute 
= DOMESTIC 

CUSTOMER_SERVICE_ 
PHONE_DOMEST 

The merchant’s international customer service 
phone number as entered in the International 
Phone Number field  in the customer service 
information section of the product information 
page 

PHONE with TYPE attribute 
= INTERNATIONAL 

Schedule 

CURRENCY_CODE 
The type of currency entered in the Terminal or 
when setting up a billing template 

CURRENCY_CODE 

SCHEDULE_CHARGE_ 
DATE 

The date when the customer will first be billed 
for a recurring charge. This is selected in the 
Terminal. 

SCHEDULE_CHARGE_ 
DATE 

SCHEDULE_END_ 
AMOUNT 
Only one of these will be 
applicable, depending on 
how the schedule is set 
up.  

The amount after which the customer is no 
longer rebilled. This is set up in the Terminal or 
the billing template. 

SCHEDULE_END_ 
AMOUNT 

SCHEDULE_END_COUNT 
The number of times a customer will be rebilled 
for a schedule. This is set up in the Terminal or 
the billing template. 

SCHEDULE_END_COUNT 

SCHEDULE_END_DATE 
The specific date when a schedule is to be 
completed. This is set up in the Terminal or the 
billing template. 

SCHEDULE_END_DATE 

TRIAL_FREQUENCY_ 
INTERVAL 

The numeric portion of the trial time, which is set 
up in the Terminal or billing template 

FREQUENCY_INTERVAL 
with TYPE=TRAL 

TRIAL_FREQUENCY_ 
TYPE 

The time unit of the trial (day, week, etc.), which 
is selected in the Terminal or billing template 

FREQUENCY_TYPE  
with TYPE=TRAL 

SCHEDULE_TO_DATE_ 
AMOUNT 

The amount to date a customer has been billed 
for a schedule 

This is a calculation 
performed by the system 

SCHEDULE_TO_DATE_ 
COUNT 

The number of times to date a customer has 
been billed for a schedule 

This is a calculation 
performed by the system 

SCHEDULE_ 
DESCRIPTION 

The description of the schedule entered in the 
billing template 

SCHEDULE_ 
DESCRIPTION 

SCHEDULE_ID 
The unique iPAY-generated identifier for a 
schedule; available on the view customer page. 

SCHEDULE_ID

INITIAL_AMOUNT 

The initial amount a customer is charged, if 
different from the amount to be charged for all 
subsequent rebills. This is selected in the 
Terminal or the billing template 

INITIAL_AMOUNT 

AMOUNT 
The amount to be charged to the customer for 
each rebilling for a schedule. This is selected in 
the Terminal or the billing template. 

AMOUNT 
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Email Token Description XML tag 
SCHEDULE_START_ 
DATE 

The date when the customer begins to receive 
the service. This is selected in the Terminal. 

SCHEDULE_START_ 
DATE 

SCHEDULE_LAST_ 
CHARGE_DATE 

The date of the last billing occurrence for the 
customer 

This is a calculation 
performed by the system 

SCHEDULE_CANCEL_ 
DATE 

The date the customer requested or initiated 
cancellation of the service (this is a date/time 
stamp) 

This is a calculation 
performed by the system 

SCHEDULE_CANCEL_ 
EFFECTIVE_DATE 

The date the cancellation of a schedule actually 
becomes effective. This is entered in the 
Terminal in the Cancel effective date field in the 
schedule information section. 

EFFECTIVE_DATE 

SCHEDULE_EXPIRE_ 
DATE 

Date when the schedule will come to its natural 
end. This is displayed in the view customer 
page under schedule information. 

This is a calculation 
performed by the system 

FREQUENCY_INTERVAL 
The numeric portion of the frequency setting. 
This is selected in the Terminal or billing 
template 

FREQUENCY_INTERVAL 

FREQUENCY_TYPE 

This is the time unit for the frequency (day, 
week, etc.) and is selected in the Terminal 
(under Recurrence Pattern) or the billing 
template 

FREQUENCY_TYPE 

FREQUENCY_DATE 

If the schedule is set to bill the customer on a 
specific date, this is the rebill date as set in the 
schedule information section of the Terminal 
when a Recurrence Pattern of Monthly or Yearly 
is selected. 

FREQUENCY_DATE 

FREQUENCY_MONTH 

If the schedule is set to bill the customer on a 
specific date, this is the month as set in the 
schedule information section of the Terminal 
when a Recurrence Pattern of Yearly is 
selected. 

FREQUENCY_MONTH 

FREQUENCY_DAY 

This is the day on which a weekly, monthly, or 
yearly rebill is to occur, if that’s how the 
schedule has been set up in the schedule 
information section of the Terminal.  

FREQUENCY_DAY 

FREQUENCY_DAY_ 
SUBTYPE 

This further modifies the FREQUENCY_DAY. 
For example, if the customer is billed on the first 
Monday of every month, “first” is the 
FREQUENCY_DAY_SUBTYPE, “Monday” is 
the FREQUENCY_DAY, and “month” is the 
FREQUENCY_TYPE. 

FREQUENCY_DAY with a 
TYPE attribute 

MERCHANT_NAME 
The alternate merchant name entered in the 
Merchant Name field in the Terminal or billing 
template 

MERCHANT_NAME 

MERCHANT_STATE 
The alternate merchant state entered in the 
Merchant State field in the Terminal or billing 
template 

MERCHANT_STATE 

MERCHANT_PHONE 
The alternate merchant phone entered in the 
Merchant Phone field in the Terminal or billing 
template 

MERCHANT_PHONE 

User Data Fields 

USER_DATA_0 through 
USER_DATA_19 

User-defined data fields that can have 
customized data labels assigned in the Custom 
Data Fields section of the main menu 

USER_DATA_0 through 
USER_DATA_19 
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